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Purpose of this Manual

The Quick Start Guide contains an example of application of the CoMPASS read‐
out software release 2.6.3, which is compliant with the following board firmware
versions:

Board Family Firmware Type Firmware revision
720 DPP‐PSD 4.29_131.16

DT5790 DPP‐PSD 4.29_131.16
725 DPP‐PSD 4.30_136.22
725S DPP‐PSD 4.30_136.140
730 DPP‐PSD 4.30_136.22
730S DPP‐PSD 4.30_136.140
751 DPP‐PSD 4.23_132.09
751 DPP‐PSD 4.29_132.38
724 DPP‐PHA 4.29_128.39
724 DPP‐PHA 4.30_128.81
780 DPP‐PHA 4.30_128.81
781 DPP‐PHA 4.30_128.81

V1782 DPP‐PHA 4.30_128.81
725 DPP‐PHA 4.29_139.10
725S DPP‐PHA 4.29_139.137
730 DPP‐PHA 4.29_139.10
730S DPP‐PHA 4.29_139.137
740D DPP‐QDC 4.29_135.17
2740 DPP‐PHA 2025102402
2745 DPP‐PHA 2025102402
2730 DPP‐PHA TBD
2740 DPP‐PSD 2025052200
2745 DPP‐PSD 2025052200
2730 DPP‐PSD 2025052203
2751 DPP‐PSD TBD

For future release compatibility check the release notes files.

Change Document Record

Date Revision Changes
September 28th, 2017 0 Initial Release
November 9th, 2017 1 Added support to CoMPASS for Linux OS.

December 12th, 2017 2 Modified Statistics tab. Added ”Real time playback” in
the Offline run.

February 6th, 2018 3 Modified Unfiltered/Filtered plot graphics.
February 23rd, 2018 3.1 Modified Time Selection tab.
May 18th, 2018 4 Modified Sec. How to Save the Data
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September 27th, 2018 5
Modified Sec. Software Connection, Sec. Start/Stop
the acquisition and spectra visualization and Sec. How
to Save the Data.

October 19th, 2018 6 Added Sec. How to create and use Virtual Channels
(Add‐back)

January 14th, 2019 7 Modified binary list file format. Updated software GUI
to rev. 1.1.0.

March 13th, 2019 8
Updated binary list file format. Added Time stamp limits
in Sec. Save the list of Trigger Time Stamp, Energy, PSD
and waveforms.

July 30th, 2019 9

Updated Sec. Linux Installation. Updated Sec.
Start/Stop the acquisition and spectra visualization.
Added Sec. How to select a ROI and Sec. How to
reprocess the CoMPASS data files. Added support to
V1782 Octal MCA.

December 13th, 2019 10

Added support to x725S and x730S. Added support to
DT5790. Added Sec. How to power on/off the high
voltage (x780 family and DT5790 only). Modified Sec.
How to Save the Data.

April 1st, 2020 11

Added support to DT5780 family. Added Sec. Dead time
evaluation in CoMPASS. Modified Sec. Software
Connection, How to select a ROI, Sec. How to power
on/off the high voltage (x780 family and DT5790 only)
and Sec. How to Save the Data.

August 7th, 2020 12
Added support to x740D family and DPP‐QDC firmware.
Added Chapt. Troubleshooting. Updated Sec. Software
Connection. Updated Sec. How to use the Settings Tab

January 10th, 2021 13 Updated Sec. How to Save the Data.

February 17th, 2021 14 Added Section Digitizer Synchronization Guide.
Modified Sec. How to use the Settings Tab.

December 23rd, 2021 15

Added Support to 2740 family. Added Sections Create a
new CoMPASS Project, Open a CoMPASS Project.
Updated Sec. Introduction, Software Connection,
Before starting the acquisition, How to configure the
channel settings, How to Save the Data, Digitizer
Synchronization Guide and Dead time evaluation in
CoMPASS. Completely revised Sec. How to reprocess
the CoMPASS data files.

January 14th, 2022 16 Added Support to V4718. Updated Sec. Create a new
CoMPASS Project.

February 8th, 2022 17

Added Support to 2745 family. Updated Sec. Drivers
Installation, Create a new CoMPASS Project. Added
Sec. Save and Load configuration and How to
(remotely) control CoMPASS from command line or
external script .

February 15th, 2022 18
SNAP installation package available again. Updated Sec.
How to Save the Data and How to (remotely) control
CoMPASS from command line or external script .

July 1st, 2022 19
Added support to 2740 and 2745 DPP‐PSD firmware.
Updated Sec. How to configure the channel settings
and Troubleshooting

September 23rd, 2022 20 Updated board firmware releases compliance table.
Updated Sec. How to Save the Data
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September 13th, 2023 21 Updated Copyright Section, Chapt. Technical Support
and End Page. Updated Chapt. Troubleshooting.

November 30th, 2023 22 Updated Sec. Save the list of Trigger Time Stamp,
Energy, PSD and waveforms.

April 8th, 2024 23

Added support to 2730 DPP‐PSD. Added support to
A5818 PCI Express Gen 3 CONET2 Controller. Added Sec.
Integrated charge evaluation from CoMPASS saved
waveforms. Updated Sec. Drivers Installation, How to
use the Settings Tab, How to Save the Data,
Troubleshooting.

September 25th, 2024 24

Added Sec. Integrated charge evaluation from
CoMPASS saved waveforms and Generalized Time of
Flight analysis: the Any to Any ΔT configuration.
Updated Sec. Hardware Installation,Windows
Installation, Linux Installation, How to Save the Data,
Digitizer Synchronization Guide, Troubleshooting.

March 19th, 2025 25 Extended Multilanguage Support. Updated Sec. Quick
Start Guide, How to Save the Data

December 16th, 2025 26

Added support to 2730 DPP‐PHA and 2751 DPP‐PSD.
Updated Sec. Save the list of Trigger Time Stamp,
Energy, PSD and waveforms, Sec. How to create and
use Virtual Channels (Add‐back), Sec. How to
(remotely) control CoMPASS from command line or
external script and Sec. Digitizer Synchronization
Guide and Sec. Troubleshooting. Added Sec. Batch
mode data acquisition using an external script.

Symbols, abbreviated terms and notation

ADC Analog‐to‐Digital Converter
AMC ADC & Memory Controller
DAQ Data Acquisition
DAC Digital‐to‐Analog Converter
DC Direct Current
DPP Digital Pulse Processing
DPP‐QDC DPP for Charge to Digital Converter
DPP‐PHA DPP for Pulse Height Analysis
DPP‐PSD DPP for Pulse Shape Discrimination
LVDS Low‐Voltage Differential Signal
ROC ReadOut Controller
USB Universal Serial Bus

Reference Documents

[RD1] W. R. Leo. Techniques for Nuclear and Particle Physics Experiments. Ed. by Springer. II ed.
[RD2] AN2506 ‐ Digital Gamma Neutron discrimination with Liquid Scintillators.
[RD3] L.Stevanato et al. “Pulse shape discrimination with fast digitizers”. In: NIM A 748 (2014), pp. 33–38.
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[RD4] AN6872 ‐ Energy and Timing characterization of two CeBr3 detectors with a DT5730 digitizer and
CoMPASS.

[RD5] AN5830 ‐ Comparison between two CAEN MCAs and two CAEN Digitizers.
[RD6] UM8717‐ 2740/2745 Digitizers User Manual.
[RD7] UM11111 ‐ CAEN Toolbox ‐ Software suite for CAEN Boards User Manual.
[RD8] GD2783 ‐ First Installation Guide to Desktop Digitizers & MCA.
[RD9] V1718 & VX1718 User & Reference Manual.
[RD10] UM7685 ‐ V3718/VX3718 VME to USB‐2.0/Optical Link Bridge.
[RD11] UM8305 ‐ V4718/VX4718 VME to USB 3.0/Ethernet/Optical Link Bridge.
[RD12] Technical Information Manual of A2818 PCI Optical Link Controller.
[RD13] Technical Information Manual of A3818 PCI Express Optical Link Controller.
[RD14] UM10551 A5818 PCI Express Gen 3 CONET2 Controller.
[RD15] DS7799 ‐ A4818 USB 3.0 to CONET Adapter Data Sheet.
[RD16] UM1934 ‐ CAENComm User & Reference Manual.
[RD17] UM1935 ‐ CAENDigitizer User & Reference Manual.
[RD18] UM7788 ‐ FELib PHA Parameters User Manual.
[RD19] UM8762 ‐ FELib PSD Parameters User Manual.
[RD20] UM5960 ‐ CoMPASS User Manual.
[RD21] UM4380 ‐ 725‐730 DPP‐PSD Registers Description.
[RD22] UM6769 ‐ 724‐781‐782 DPP‐PHA Registers Description.
[RD23] UM6771 ‐ 780 DPP‐PHA Registers Description.
[RD24] AN2086 ‐ Synchronization of CAEN Digitizers in Multiple Board Acquisition Systems.

All CAEN documents can be downloaded at:
www.caen.it/support-services/documentation-area

www.caen.it/support-services/documentation-area


Manufacturer Contacts

CAEN S.p.A.
Via Vetraia, 11 55049 Viareggio (LU) ‐ ITALY
Tel. +39.0584.388.398 Fax +39.0584.388.959
www.caen.it | info@caen.it
©CAEN SpA – 2025

Limitation of Responsibility
If thewarnings contained in thismanual are not followed, CAENwill not be responsible for damage caused
by improper use of the device. The manufacturer declines all responsibility for damage resulting from
failure to comply with the instructions for use of the product. The equipment must be used as described
in the user manual, with particular regard to the intended use, using only accessories as specified by the
manufacturer. No modification or repair can be performed.

Disclaimer
No part of this manual may be reproduced in any form or by any means, electronic, mechanical, record‐
ing, or otherwise, without the prior written permission of CAEN SpA.

The information contained herein has been carefully checked and is believed to be accurate; however,
no responsibility is assumed for inaccuracies. CAEN SpA reserves the right to modify its products speci‐
fications without giving any notice; for up to date information please visit www.caen.it.

Made in Italy
We remark that all our boards have been designed and assembled in Italy. In a challenging environment
where a competitive edge is often obtained at the cost of lower wages and declining working conditions,
we proudly acknowledge that all those who participated in the production and distribution process of
our devices were reasonably paid and worked in a safe environment (while this is true for the boards
marked ”MADE IN ITALY”, we cannot guarantee for third‐party manufactures).
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1 Introduction
The function of the Front End electronics in nuclear physics applications is to acquire the electrical charge
pulses generated by a detector, to extract the quantities of interest and to convert them into a digital
format. These information are then acquired, saved and analyzed by a computer. In most applications,
relevant quantities are the particle energy (proportional to the charge released by the particle in the de‐
tector) and the time of arrival; in some cases the acquisition is restricted to the pulse counting, actually a
“selective” counting, meaning that one or more energy intervals or other criteria are used to select which
particles must be counted. In some other cases, it is necessary to discriminate the type of the particle
by means of the pulse shape; for example, the γ‐n discrimination is based on a detector response varia‐
tion when stimulated by a gamma or a neutron; this variation leads to a different rise and/or decay time
of the pulse. The acquisition system is usually completed by digital logic units whose purpose is to per‐
form (anti)coincidences, generate triggers, vetoes and other signals that take into account the correlation
between different channels and may give further information such as the particle position or trajectory.

DETECTOR
TIMING CHARGE = ENERGY

POSITION or TRAJECTORY

INCIDENT PARTICLE

Fig. 1.1: Electrical charge pulse generated by a particle interacting with a detector.

Nowadays, the availability of very fast and high precision flash ADCs permits to design acquisition systems
in which the Analog to Digital conversion occurs as close as possible to the detector. In principle, this
acquisition system allows to minimize the information loss. Actually, the acquisition will be affected by
uncertainties due to the quantization noise and to other sources of electronic noise. In general, the appli‐
cations that require precise timing measurements are more oriented to the use of high sample frequency
digitizers (500 MS/s or more), while the 12‐14 bit digitizers are well suited for acquisitions where high
energy resolution is a pre‐requisite.
In recent years, the use of waveform digitizers for readout of radiation detectors has become popular in
many different physics applications: the conventional analog electronics is going to be replaced by a full dig‐
ital approach, where the detector output (with or without preamplifier, depending on the detector type) is
directly connected to the digitizer input. This approach is especially beneficial in multi‐parametric acquisi‐
tion systems, where the analysis involves different quantities and parameters, such as energy, pulse shape
and timing. In fact, thanks to Digital Pulse Processing (DPP) it is possible to apply dedicated algorithms on‐
line (typically in the FPGAs), to extract the information of interest from the raw waveform. DPP algorithms
allow the digitizer to implement in “one single box” the different functionalities of the old fashion TDC,
QDC, Peak Sensing ADC, discriminator and other analog and logic modules [RD1]. Furthermore, the DPP
allows the digital readout to be sustainable in terms of data throughput because the full waveform is not
necessarily read out but used for debugging purposes only. This results in an “all‐in‐one, multi‐parametric
digital DAQ for physics applications”.
CAEN has developed a complete family of waveform digitizers well suited for physics, medical, homeland
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Fig. 1.2: All‐in‐one Spectroscopy DAQ.

security and industrial applications. They are available in different form factors (VME, Desktop and NIM)
as showed in Tab. 1.1. In addition, CAEN developed also several digital pulse processing algorithms that
allows the user to extract a set of significant information like energy, precise timing, PSD and so on [RD1].
Tab. 1.2 shows the functionalities supported by the different models and that will be described in the
following sections.
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Tab. 1.1: CAEN Waveform Digitizers selection table.

CoMPASS is the new software from CAEN able to implement a Multi‐parametric DAQ for Physics Appli‐
cations, where the detectors can be connected directly to the digitizers inputs and the software acquires
energy, timing, and PSD spectra. CoMPASS software has been designed as a user‐friendly interface to
manage the acquisition with all the CAEN DPP algorithm. CoMPASS can manage multiple boards, even in
synchronized mode, and the event correlation between different channels (in hardware and/or software),
apply energy and PSD cuts, calculate and show the statistics (trigger rates, data throughput, etc...), save the
output data files (raw data, lists, waveforms, spectra) and use the saved files to run off‐line with different
processing parameters.
CoMPASS Software supports CAEN first generation digitizers x720, x724, x725, x730, x740D, x751 digitizer
families running the DPP‐PSD, DPP‐PHA and DPP‐QDC firmware, the x780, x781 and x782MCA family, the
DT5790 Pulse Processor and the second generation digitizer x2740, x2745, x2730 and x2751 running the
DPP‐PSD and DPP‐PHA firmware. More details about the supported boards and firmware are given in the
following sections.
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Tab. 1.2: Functionalities implemented in the CAEN digital algorithms and supported by the digitizers.

Note: 725, 730 and 751 series requires the calibration of the ADCs before starting the acquisition. CoMPASS
performs the calibration at every start acquisition. 725S and 730S series do not require the ADC calibration.

Note: From now on 725/730 series will include 725 and 725S/730 and 730S respectively unless otherwise
specified.
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2 Quick Start Guide

2.1 Scope of the Chapter
This chapter is intended to provide the userwith a quick guide of the CoMPASS Software, to dealwith aDPP‐
PSD and a DPP‐PHA System in a practical use. For a demo purpose we used a gamma source of Cobalt‐60
only. The user can refer to [RD2] and [RD3] for a real neutron – gamma discrimination application, to [RD4]
for a mixed Energy/Timing measurement application and to [5] for a real high resolution spectroscopy
application. All steps in this chapter are made with the 730 series (in the DPP‐PSD case) and 725 (in the
DPP‐PHA case). The same behaviour can be generalized to the 720, 725, 751, 2740, 2745, 2730 and 2751
series, as well as the DT5790 (for DPP‐PSD) and to the 724, 730, 780, 781, 782, 2740, 2745 and 2730 (for
DPP‐PHA). Exceptions and specific functioning will be explicitly mentioned in the text.

2.2 Hardware Installation
CAEN’s DPP‐PSD System proposed in the chapter consists of the following CAEN products:

• DT5730S, 8‐channel 14‐bit 500 MS/s Desktop Digitizer.
• DPP‐PSD firmware for 730S series (release 4.29_136.138), running on the Digitizer.
• DT5534, 4 Channel 6 kV/1 mA (4 W) Desktop HV Power Supply Module
• CoMPASS Software for data acquisition, release 2.5.0, running on the host station
• GECO2020 Software for power supply management, release 1.13.1, running on the host station.

The digitizer running the DPP‐PSD algorithm receives on channel 0 the signal from a NaI(Tl) coupled with
a PMT. The CAEN DT5534 (a 4‐channel, HV Programmable Power Supply board) provides the supply to the
detector (Vbias = 800 V). A Cobalt‐60 (60Co) gamma ray source (counting rate∼ 1 kHz) is used. A computer
equippedwith aMicrosoftWindows 11 64‐bit OS acts as host station in which the CoMPASS and GECO2020
are running. The communication protocol between the computer and the Digitizer is USB (2.0 version).
Connect the SHV cable for the high voltage power supply to the HV0 connector of the DT5534. Connect
the PMT output to the DT5730S CH0. Connect the digitizer and the HV power supply to the PC with the
preferred communication interface between USB and Optical link (USB and Ethernet for the power supply).

CAEN’s DPP‐PHA System proposed in the chapter consists of the following CAEN products:

• DT5725S, 8‐channel 14‐bit 250 MS/s Desktop Digitizer.
• DPP‐PHA firmware for 725S series (release 4.29_139.137), running on the Digitizer.
• DT5521HE, 4 Channel 6 kV/20 µA Desktop HV Power Supply Module
• DT5423, Desktop Linear Power Supply
• CoMPASS Software, release 2.5.0, running on the host station
• GECO2020 Software, release 1.13.1, running on the host station.

The digitizer running the DPP‐PHA algorithm receives on channel 0 the signal from a HPGe. The CAEN
DT5521H (a 4‐channel, HV Programmable Power Supply board) provides the supply to the detector (Vbias
= 5500 V). The low voltage for the preamplifier is provided by the DT5423 a desktop linear power supply.
A Cobalt‐60 (60Co) gamma ray source (counting rate ∼ 1 kHz) is used. A computer equipped with a Mi‐
crosoft Windows 10 64‐bit OS acts as host station in which the CoMPASS and GECO2020 are running. The
communication protocol between the computer and the Digitizer is USB (2.0 version).
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NaI (Tl) + PMTCo60

DT5730
+

DPP-PSD Firmware

PC 
+ 

GECO2020 and CoMPASS

High Voltage 
Power Supply

DT5534E

HV

Signal

Fig. 2.1: The hardware setup including the digitizer running the DPP‐PSD firmware used for the typical medium reso‐
lution measurements using NaI(Tl) detectors application.

PC + CoMPASS + GECO2020

Communication link 
between digitizer and PC

DT5725
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DPP-PHA

High Voltage 
Power Supply

DT5521H

Low Voltage
Power Supply

DT5423 

Power Inhibit 

HPGe detector

Radioactive 
source

HV

Signal

Low Voltage

Fig. 2.2: The hardware setup including the digitizer running the DPP‐PHA firmware used for a typical high resolution
measurements using HPGe detectors application.

Connect the SHV cable for the high voltage power supply to the HV0 connector of the DT5521H. Connect
the low voltage to theDT5423 and the inhibit (if any) to the back panel connectors of the DT5521H. Connect
the preamplifier output to the DT5725S CH0. Then connect the digitizer and the HV power supply modules
to the PC with the preferred communication interface between USB and Optical link (USB and Ethernet for
the power supply).
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2.3 Firmware and Licensing
The firmware upgrade is an advanced feature that can be performed only in case the user wants to upgrade
the current firmware to a new version, or to upload a different firmware on the board. The .cfa file format
checks for the board model to ensure that firmware upgrade is made on the correct board.

2.3.1 How to install the firmware

2.3.1.1 V17xx, DT57xx and N67xx digitizers and MCAs

• Download theDPP‐PSD Firmware (.cfa) for the 730 series (or for your own digitizer) on CAEN
website in the ‘Download’ area of the DPP‐PSD page or from the digitizer page. Download
the correct file according to the digitizer family in use.

• Download the CAEN Toolbox software to upload the firmware on your board. The program
full installation package for Windows OS is available on CAEN website in the ‘Download’
area at the CAEN Toobox page.

• Unpack the installation package, launch the setup file and complete the Installation wizard.
• Run the CAEN Toolbox GUI by one of the following options:

– The desktop icon for the program
– The Quick Launch icon for the program
– The .exe file in the bin folder from the installation path on your host

• Select ”Digitizer 1.0”.
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• from the top menu select Device → Connect, insert the digitizer connection parameters
and press Connect.

• Select ‘Upgrade Firmware’.
• Select the DPP‐PSD .cfa firmware file to be uploaded on the digitizer and press Open.
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• The digitizer firmware upload will the start automatically and CAEN Toolbox does show the
operation progress.

• Once the upload is completed, power cycle the board.

• if the digitizer is a DT57xx one, CAEN Toolbox will notify the user the possibility to proceed
with an automatic reboot of the board.

The procedure for installing and upgrading the DPP‐PHA firmware is the same.
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Note: If the digitizer is connected to the DAQpc via USB, do not upgrade the board firmwarewhile running
CoMPASS. The concurrent access to the digitizer flash memory done by CAEN Toolbox and CoMPASS might
lead to an interruption of the CAEN Toolbox writing process with a consequent flash memory corruption.

2.3.1.2 V/VX27xx and DT27xx digitizers

This section is of course not related to the specific example described in this chapter. However
we do include it as well because the prescription and the advises included here may be easily
extended to the V/VX27xx and DT27xx digitizers as well. For this reason it’s useful to have here
a quick guide about their firmware upgrade as well.
The V/VX27xx and DT27xx digitizers firmware upgrade can be done either using CAEN Toolbox
or the embedded Web Interface[RD6]. Here the procedure using thee mbedded web interface
is shown. The Firmware section deals with firmware management.

Fig. 2.3: Firmware page.

The Digitizer can store multiple firmware on‐board. Such firmware can be either different up‐
dates of the same firmware type, or different firmware types (Scope or DPP), indifferently. Each
stored firmware is visible on this page. The User can perform a new firmware upload, select
which firmware must be loaded on the FPGA at the reboot (Default), and which firmware must
be the current operating firmware (Current). The factory firmware (Factory) cannot in any way
be deleted and guarantees communication with the board even in case it is compromised with
any other firmware.
Firmware settings:

• Apply: Sets the firmware as the current operating firmware (green label). The selected
firmware is loadedwithout the need of rebooting the hardware. The current FPGAfirmware
version is updated in the Board Information of the Dashboard page.

• Set as default: Makes the selected firmware the one to be loaded after the device reboot
(light blue label).

• Delete: Deletes the firmware from the Digitizer memory. Note that the factory firmware
(red label) cannot be deleted.

• See details: Shows the changelog information for the selected firmware.

The firmware file is a CUP file, which is an archive of files including the firmware for all the pro‐
grammable components present on the 2740 digitizer (FPGA, CPU, etc.). By upgrading the CUP
file, all the components are upgraded at once. The standard name of the CUP file is:

<model>‐<type>‐<firmware‐version>‐1GbE.CUP

where

• <model> is the digitizer model (e.g. V2740);
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Fig. 2.4: The firmware changelog.

• <type> is the firmware type identifier (e.g. scope);
• <firmware‐version> is the firmware version.

Each stored firmware generates a raw in this section, reporting the firmware revision and the
firmware type (scope, DPP, etc.) just below.

The upgrade procedure is the following:

• Press the “Upload new firmware” button.
• Use the “Browse” button in the upgrade window to point to the CUP file.
• Press the “Upload” button to start the upgrade.

Fig. 2.5: Firmware upgrade window.

• The selected firmware will be automatically set as Current at the end of the process.

Fig. 2.6: Firmware upgrade done.
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• Reboot by the “Reboot device” option to make the new firmware upgrade effective.

Note that when running the CoMPASS Software, the program checks for the firmware loaded in the target
Digitizer. If no license is found the software will show it in the ”Board Properties” section, and at the start
of the acquisition, a pop‐up warning message shows up and reports the time left before the acquisition is
stopped (trial version). To unlock the DPP firmware and to use it without any time limitation, you need to
purchase a license from CAEN. Refer to [7] for detailed instructions on how to use CAEN Toolbox and the
licensing procedure.

Fig. 2.7: CoMPASS Board Settings section with the indication of a not licensed DPP‐PHA firmware.

Fig. 2.8: CoMPASS time bomb remaining time warning.

2.4 Software Setup

2.4.1 Drivers Installation

According to the preferredway of connection to the digitizer, usersmust also take care of proper installation
of USB or optical drivers. CAEN provides the drivers for all the different types of physical communication
interfaces featured by the specific digitizer and compliant with Windows OS.

• USB 2.0 Drivers for NIM/Desktop boards are downloadable on CAEN website (www.caen.it) in the
“Software/Firmware” tab of the digitizer/MCA web page (login required).

Note: Windows OS USB driver installation for Desktop/NIM digitizers is detailed in [8].

• USB 2.0 Drivers for V1718 and V3718 CAEN Bridge, required for the VME boards interface, are down‐
loadable on CAEN website (www.caen.it) in the “Software/Firmware” tab of the V1718 and V3718
web page (login required).

Note: For the installation of the V1718 and V3718 USB driver, refer to the User Manual of the Bridge [9]
[10].

• USB 3.0 Drivers for V4718 CAEN Bridge, required for the VME boards interface, are downloadable on
CAENwebsite (www.caen.it) in the “Software/Firmware” tab of the V4718 web page (login required).

Note: For the installation of the V4718 USB 3 driver, refer to the User Manual of the Bridge [11].
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• Optical Link Drivers are managed by the A2818 PCI card, the A3818 PCIe card or the A5818 PCIe card.
The driver installation package is available on CAEN website in the “Software/Firmware” area at the
A2818, A3818 and A5818 page (login required)

Note: For the installation of the Optical Link driver, refer to the User Manual of the specific Controller [12]
[13] [14].

• USB 3.0 Drivers for A4818 adapter are downloadable on CAEN website (www.caen.it) in the “Soft‐
ware/Firmware” tab of the A4818 web page (login required).

Note: For the installation of the A4818 USB 3 driver, refer to the datasheet of the [15].

Note: It is recommended to install the driver before to connect the hardware.

Note: x27xx digitizer family does not require any USB driver to be installed in Windows. They are required
in Linux only.

In our case we are going to describe the procedure for USB connection.

2.4.2 How to install the driver (Windows)

• Download the latest release of theUSBdriver forWindowsonCAENwebsite in the ‘Software/Firmware’
area at the digitizer page.

• Unpack the driver package.
• Power on the Digitizer and plug the USB cable in a USB port on your computer.
• Windows will try to find drivers and, in case of failure the message “Device driver software was not

successfully installed” is displayed and the driver needs to be installed manually:
• Go to the system’s ’DeviceManager’ through the Control Panel and check for the CAENDT5xxxUSB1.0

unknown device.
• Right click and select Driver software update in the scrolling menu.
• Select the option to ’Browse my computer’ for driver software.
• Point to the driver folder and finalize the installation.

2.4.3 How to install the driver (Linux)

In case of a DT57xx and N67xx digitizer:

• Download the latest release of the USB driver for Linux on CAEN website in the ‘Software/Firmware’
area at the digitizer page.

• Unpack the driver package (tar –zxf CAENUSBDrvB‐xxx.tgz).
• Go to the driver folder (cd CAENUSBDrvB‐xxx).
• Follow the instructions on the Readme.txt file.
• Type:

make
sudo make install
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• Reboot your machine

In case of a 27xx digitizer:

• Download the latest release of the USB driver for Linux on CAEN website in the ‘Software/Firmware’
area at the digitizer page.

• Unpack the driver package (tar –zxf CAENDGTZ‐USB‐Drv‐x.y.tgz).
• Go to the driver folder (cd CAENDGTZ‐USB‐Drv‐x.y).
• Follow the instructions on the Readme.txt file.
• Type:

sudo ./install.sh
sudo sudo ./regPID.sh in case your Linux distribution is not able to automatically retrieve the
Digitizer USB name (CAENDGTZ‐USB‐{PIDNUMBER})

• Reboot your machine

2.4.4 Libraries

CoMPASS software requires the following embedded CAEN libraries to manage the communication, con‐
figuration and readout of the digitizers:

• CAENComm library manages the communication at low level (read and write access). The purpose
of the CAENComm is to implement a common interface to the higher software layers, masking the
details of the physical channel and its protocol, thus making the libraries and applications that rely on
the CAENComm independent from the physical layer. Moreover, the CAENComm requires the CAEN‐
VMELib library (access to the VME bus) even in the cases where the VME is not used. Reference
document: [16]

• CAENDigitizer is a library of functions designed specifically for the Digitizer family, which supports the
DPP firmware. The CAENDigitizer library is based on the CAENComm library. Reference document:
[17].

• CAEN_FE_lib is a library that can be used to control and acquire data new generation CAEN digitizers.
This library is just an interface and does not includes support to any digitizer family. In order to use a
digitizer you must install first the respective underlying library. Reference documents: [18], [RD19].

• CAEN_DIG1_lib is the high level library of functions designed specifically for CAEN V/VX17xx, DT57xx,
N67xx first generation digitizers. Reference document: N/A.

• CAEN_DIG2_lib is the high level library of functions designed specifically for CAEN 27xx second gen‐
eration digitizers. Reference document: N/A.

Note: The most updated documentation about the FELib and Dig2 can be retrieved directly from the 27xx
digitizer web interface.

Note: The software is stand‐alone and does not require the prior installation of the libraries (both for
Windows and Linux OS).
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2.4.5 CoMPASS Installation

In order to be able to install CoMPASS, the host station needsWindows 10 build 15063 (or later) or Linux
64 bit OS.

• Make sure that your hardware (Digitizer and/or Bridge, or Controller) is properly installed (refer to
the related User Manual for hardware installation instructions).

• Make sure you have installed the driver for your OS and the physical communication layer to be used.
Driver installation packages are downloadable from CAEN website (login required) as reported in the
section Drivers Installation (refer to the related User Manual for driver installation instructions)

CAEN provides the full installation package for the CoMPASS Software in a standalone version forWindows
and Linux OS. This version installs all the binary files and required libraries.

1. Download the CoMPASS Software for your OS from CAEN Website under the path: Home / Products
/ Firmware/Software / Digitizer Software / Readout Software / CoMPASS

2. Extract the files

2.4.5.1 Linux Installation

In case of Linux OS there are two possible installation procedure:

1. Procedure 1:
• Use the software manager Snap for Linux (refer to snapcraft.io).
• Download the ”compass_version_amd64.snap” file;
• Install the software by typing

sudo snap install compass_version_amd64.snap --dangerous --devmode

The --dangerous option just means that the package has not been verified by the Snap Store
team and the --devmode option allows snap, executed in a sandbox, to access the computer
disk and peripherals.

There is no need to check for the minimal requirements as Snap will automatically install all the
additional required packages.

2. Procedure 2:
• Download the ”CoMPASS‐version.tar.gz” file and unzip it;
• Please check that your gcc and g++ compiler are≥ 11.4.0, that glibc is≥ 2.34 and that glibcxx is
≥ 3.4.30.

• To install the software type
sudo sh install.sh

Missing packages are detected by the setup and the user must install them to continue the CoM‐
PASS installation.
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2.4.5.2 Windows Installation

Run the executable “CoMPASS_version.exe” and the Setup Wizard will guide you throughout the installa‐
tion procedure.
The CoMPASS Setup Wizard will first look for already present CoMPASS installation. If it finds it, it will ask
the user to first uninstall the previous installation automatically.

Fig. 2.9: CoMPASS Wizard Dialog Box ‐ Detection of previous CoMPASS installation.

Click Yes to proceed with the old CoMPASS version uninstall.

Fig. 2.10: CoMPASS Wizard Dialog Box ‐ Uninstall of previous CoMPASS installation.
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Fig. 2.11: CoMPASS Wizard Dialog Box ‐ Start Installation.

The ComPASS installer looks for the presence on your system of possible incompatible packages; if it finds
them a pop up appears asking to remove them before completing the installation.

Fig. 2.12: CoMPASS incompatible packages pop up.

The ComPASS installer looks for the presence on your system of the required OS packages; if it does not
find them a pop up appears asking to install them.

Fig. 2.13: CoMPASS Requirements pop up.

Proceed with the required package installation and then the main Installation Wizard occurs.

Please read the CoMPASS Software License Agreement and select “I accept the agreement” to continue
the installation. Left click on “Next” (or left click on “Back” at any time during the installation process to
modify the previous settings).
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Fig. 2.14: CoMPASS Wizard Dialog Box ‐ License Agreement.

Choose the CoMPASS installation path. By default the C:\CoMPASS path is proposed.

Fig. 2.15: CoMPASS Wizard Dialog Box ‐ Installation path selection.

Press ”Browse” if you want to change it with a different path.
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Fig. 2.16: CoMPASS Wizard Dialog Box ‐ Installation path change window.

If the selected installation folder already exist CoMPASS does ask the user for the overwrite confirmation.

Fig. 2.17: CoMPASS Wizard Dialog Box ‐ Installation folder overwrite confirmation.

Optionally, mark the checkbox labelled “Create a desktop icon” to create an CoMPASS icon on your com‐
puter Desktop. Left click on “Next” to continue.
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Fig. 2.18: CoMPASS Wizard Dialog Box ‐ Desktop Icon Selection.

Check the installation setting summarywindowandpress “Install”when ready to install the CAENCoMPASS
Software.

Fig. 2.19: CoMPASS Wizard Dialog Box ‐ Installation.

The CAEN CoMPASS Setup Wizard will extract and install the relevant files.
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Fig. 2.20: CoMPASS Wizard Dialog Box ‐ Installation progress.

At the end of the installation, the following Dialog Box will appear:

Fig. 2.21: CoMPASS Wizard Dialog Box ‐ Software Release Version Notes.

Please read the Release Notes of the CoMPASS Software before continuing. This document is updated for
every official release of CoMPASS and it contains various updated information specific to this software.
To complete the CoMPASS Installation left click on “Finish”. The CoMPASS Program can be launched by
marking the check box “Launch CoMPASS” before finishing the installation, or by left clicking on the in‐
stalled icons in the Start Menu Folder.
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Fig. 2.22: CoMPASS Wizard Dialog Box ‐ Finish Installation.
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2.5 Software Connection
Once you have installed the required driver for the communication interface and the CoMPASS software
you can launch the CoMPASS software and connect it to the DT5730S and DT5725S at the same time.

At the first connection it is required to guarantee firewall access to CAENDPPServer and CoMPASSplot (first
time only)

Fig. 2.23: Firewall access to CAENDPPServer.

Fig. 2.24: Firewall access to CoMPASSplot.

At the CoMPASS startup both the software configuration GUI (Fig. 2.25) and the CoMPASS Plot (Fig. 2.26)
will be opened.
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Fig. 2.25: CoMPASS Start window.

Fig. 2.26: CoMPASS Plot Start window.
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From the main panel of the CoMPASS software GUI you can change the software language by selecting
TOOLS ‐> Select Language. A popup appears allowing to select the desired language.

Fig. 2.27: CoMPASS language selection window.

Currently the following languare are supported:

• English
• Chinese
• Japanese
• Korean
• Italian
• French
• German
• Spanish
• Portuguese
• Finnish
• Dutch
• Swedish
• Polish
• Russian
• Ukrainian
• Turkish
• Arabic
• Jewish

More language will come in future releases.

Note: The user is encouraged to contact CAEN at the official support platform to spot possible translation
mistakes or to request to extend the multi‐language support to a specific language.
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2.6 Create a new CoMPASS Project
From the main panel of the CoMPASS software GUI select

FILE ‐> New Project, or press the button

A pop‐up windows will appear asking the user to select the folder in which the project will be saved. Each
project will include all the details about the involved boards, firmware and settings, as well as the acquired
data.

Fig. 2.28: CoMPASS New Project window.

Select an already existing folder or create a new one by pressing the button

If the selected folder already contains a project, CoMPASS will ask the user to continue, and so erase the
folder content, or not.

Fig. 2.29: CoMPASS not empty folder warning message.

Pressing yes, CoMPASS prepares the project environment and moves to another window in which the user
can choose if add manually one by one the available boards or let CoMPASS scan for all the connected
digitizer for any communication interface.
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Fig. 2.30: CoMPASS Scan Tab.

Pressing the button or the the user can add a single board

manually providing the connection parameters. Press ok to do the connection to the board.

Fig. 2.31: CoMPASS Add Board window.

Pressing the button or the the user let CoMPASS search for all

the active connection interfaces searching for the connected boards and automatically to the connection.
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Fig. 2.32: CoMPASS Searching for connected boards.

If a not supported board model or firmware is detected, a popup appears showing some additional infor‐
mation

Fig. 2.33: Not supported board model popup.

Fig. 2.34: Not supported firmware popup.
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After the scan has completed CoMPASS will automatically connect to the found boards and will show the
detected boards as:

• list of all the available boards and their status in the CoMPASS Plot Run Data Source Section (Fig. 2.35)
• different sub‐tabs in the Settings tab (Fig. 2.36);
• separate entries in the CoMPASSPlot Statistics table (Fig. 2.37).

Two additional tabs are available to set time correlations between channels of the same board or different
boards (Fig. 2.38), and to create virtual channels as sum of individual channels (Fig. 2.39).

Fig. 2.35: CoMPASS Plot Window ‐ Run data source section.
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Fig. 2.36: CoMPASS Settings Tab.

Fig. 2.37: CoMPASSPlot Statistics Table.
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Fig. 2.38: CoMPASS Time Selection Tab.

Fig. 2.39: CoMPASS Virtual Channels Tab.
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In order to connect and use only a subset of the available boards the user has to click on the Enable tick
into the Board Properties section to enable/disable the single digitizer. The corresponding modification
will be them shown into the CoMPASS Plot Run Data Source section.

Fig. 2.40: Connected and disconnected digitizer status shown in the CoMPASS Plot Run Data Source section.
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2.7 Open a CoMPASS Project
In order to open a previously saved CoMPASS project select

FILE ‐> Open Project, or press the button

A pop‐up windows will appear asking the user to select the folder in which the project is saved.

Fig. 2.41: CoMPASS Open Project selection window.

Click on the desired folder. If a project is actually saved in the folder you will see the included boards listed
on the right section of the window
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Fig. 2.42: CoMPASS Open Project selection window with the project folder selected.

Click Open to open the project and have the corresponding digitizer settings loaded on the GUI.
If the boards are up and running, they will be automatically connected to the project and enabled and
correspondingly displayed in green in the Run Data Source section of the CoMPASS Plot. Otherwise they
will be displayed in red if they are disconnected or in grey if they are connected but disabled.

Fig. 2.43: Project board status in the Run Data Source section of the CoMPASSPlot window.

If the project folder includes also saved data, the Offline data section becomes selectable. Clicking on the
Offline data, the below sections (Boards data buffer, List, Spectra) becomes available and selecting one of
them the user can check the included data files.
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Fig. 2.44: Saved data present in the project folder as displayed in the CoMPASSPlot Window.

How to re‐process the previously saved data will be shown and explain in the dedicated section How to
reprocess the CoMPASS data files.
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2.8 Save and Load configuration
In order to save the current project settings configuration select

FILE ‐> Save configuration file as, or press the button

A popup will appear allowing to save the current configuration in the CoMPASS CONFIG folder which is by
default included in the current project folder.

Fig. 2.45: CoMPASS configuration save window.

Type the desired configuration file name and press Save.
In order to load a project settings configuration select

FILE ‐> Load configuration file, or press the button

A popup will appear allowing to load the desired configuration from the CoMPASS CONFIG folder.

Fig. 2.46: CoMPASS configuration load window.

Select the desired configuration file and press Load. The corresponding settings will then uploaded on the
digitizers.
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If more then one digitizer is part of the project such Save/Load functionality saves/loads the settings of all
the digitizers.

During the Load operation CoMPASS checks the correspondence between the boards whose settings have
been saved and the current boards included in the project. If such correspondance is notmatched, an error
message occurs and no setting is uploaded.

Fig. 2.47: CoMPASS configuration load error.
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2.9 How to power on/off the high voltage (x780 family and
DT5790 only)
Go into the HV subtab in the Settings tab and set the desired High Voltage value ”V Set” and the maximum
current ”I Set” according to your detector specifications.
Set the Maximum allowed Voltage value ”V Max”, beyond which the HV channel goes into protection.
Select the proper values for Ramp UP and ”Ramp DOWN” (”V ramp up” and ”V ramp down” respectively),
corresponding to the value of V/sec of voltage ramp.
Starts the HV by setting the Power On/Off field when ready and the check the HV status from the V Mon,
I Mon and Status fields.

Fig. 2.48: CoMPASS HV Tab.

The channels status can be also checked into the CoMPASS bottom status bar

Fig. 2.49: CoMPASS Status bar.

Note: If the HV is ON and the user disconnects the software from the digitizer, a pop up appears asking the
user which action has to be done. If the user decides to leave the HV on, the HV channels will remain ON
even at the next connections.
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2.10 Before starting the acquisition
Especially in case of a DPP‐PHA system, but also for a DPP‐PSD system, it is very important to check the pre‐
amplifier output in an oscilloscope device before feeding the pre‐amplified signal into the digitizer input.
The user must check that:

• there are no grounding loops;
• the preamplifier output dynamics is not saturated.

In the unlikely event one of the above conditions is found the user must take care of the proper work
around.

2.11 How to configure the channel settings
The correct configuration of the channel settings allows the system to reach very precise resolutions in
nuclear spectroscopy measurement. For this reason, it is very important to set them properly. This section
will guide the user throughout the settings configuration.

Note: As mentioned at the beginning of 2.2 the indication and suggestion that will be provided in this
chapter refer to the DT5780 MCA and to the DT5730(S) digitizer with DPP_PSD firmware. When using
other board models the corresponding CoMPASS settings may be slightly different. Such variation will be
mentioned when appropriate.

The first step is to start the acquisition using the the “Acquisition Mode: Waves” in the Acquisition tab in
order to check the effects of the setting modifications on the digital filters (Fig. 2.50).

Fig. 2.50: Acquisition Settings section.

In CoMPASS Plot, open the waveform plot pressing the button

Select into the field ”Global Source” the channel to be displayed.

In order to start the acquisition press the button

In AcquisitionMode ”Waves”, CoMPASSwill automatically check the value of the Event Aggregation param‐
eters. This parameter will be better described later and it corresponds to the number of events that will
be collected by the board before send them to the digitizer. Depending on the width of the Record Length,
CoMPASS will then evaluate the highest possible value of this parameter and will modify it on behalf of the
user in case the current set value exceeds the maximum one (Fig. 2.51).
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Fig. 2.51: CoMPASS Event Aggregation value warning.

Note: It is possible to hide such kind of CoMPASS warning messages selecting the corresponding option
directly on the warning pop up or selecting Tools→ Preferences ans selecting the corresponding options.

When warning popups are hidden, the user is in any case notified of their occurrence by the CoMPASS
main GUI status bar that becomes partially yellow on the left section and that show a notification triangle
on the bottom left corner.

If the board features a not licensed firmware, at the start of the acquisition a popup appears informing the
user about how much time remains before the license expires (Fig. 2.52).

Fig. 2.52: CoMPASS time bomb remaining time warning.

When the license is expired, the user has to:

• disconnect the board by deselecting the Enable option in the Setting tab→ Board Properties section
• power cycle the board
• connect again the board by selecting the Enable option in the Setting tab→ Board Properties section

2.11.1 How to use the Settings Tab

The Settings Tab and the subtabs there included allows the user to set all the acquisition parameters at the
board, group (x740D only) and single channel level. For each parameter, acting on the the ”All” column, the
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modified setting will be applied to all the channel of the board, acting on the ”GRn” columns, the modified
setting will be applied to all the channel of the group n (x740D only), while acting on the ”CHn” column the
modified setting will be applied only to the selected channel.
See for example Fig. 2.53 where it has been modified the polarity of channel 0. In this case all channels
will have negative polarity, while channel 0 will have positive polarity.

Fig. 2.53: Example of use of CoMPASS Settings Tab.

In Fig. 2.54 it is shown and example in case of the x740D board. It has been modified the threshold of
group 0 and channel 0. In this case all channels will have a threshold of 100 LSB, while group 0 will havea
threshold of 50 LSB except for channel 0 that will have a threshold of 10 LSB.

Fig. 2.54: Example of use of CoMPASS Settings Tab in case of the x740D family.

Note: The group settings on ”GRn” (x740D only) and the individual settings on ”CHn” are not modified by
the global setting on the ”All” column.

2.11.2 DPP-PSD and DPP-QDC System Parameter Optimization

It is possible to visualize a set of analog and digital traces. Start with the visualization of:

• “Input”
• “CFD”
• “Trigger”
• “Gate”

Adjust the Record Length and the Pre‐Trigger for a better visualization.

Note: In case you don’t see any signal select “Auto Trigger” in the Acquisition Tab to enable the software‐
trigger. The software will force the board to trigger the events. Then adjust the channel settings as de‐
scribed in the following sections. Once the parameters are correctly set, deselect the “Auto Trigger” option
to disable the software‐trigger.

If needed, adjust the DC Offset to avoid the saturation of the digitizer dynamic range.
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Fig. 2.55: CoMPASS Waveform Plotter window with Input, CFD, Trigger and Gate traces.

Drag and release on the X and Y axes to zoom in a region of the plot.

To zoom out press the button

In the CoMPASSmain GUI in the Settings Tab there are several sub‐tabs in which all the relevant parameters
are grouped by functionality.

Note: Any time you change one setting, always press Enter on your keyboard to apply the setting.

When two analog traces are shown in the plot (like Input and CFD in Fig. 2.55), half of the digitizer samples
are used for the first trace and the other half for the second trace. In this case the input signal might appear
at half of the digitizer sampling. To visualize the trace at full frequency, disable the second trace by selecting
the option ”None”.

Note: In case of 751 family select the option ”Analog Traces Fine Resolution” in the Input sub tab.

Note: To show/hide one of the traces displayed on the plot you just have to check/uncheck the tick close
to the corresponding trace.
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2.11.2.1 How to configure the Input Signal settings (DPP-PSD and DPP-QDC)

The first settings to be configured are those related to the Input Signal.

Fig. 2.56: Input subtab for a x730 and, as comparison, 274x digitizer (DPP‐PSD).

1. Open the Input subtab. You can choose if setting the parameters for all the digitizer channels at the
same time or setting them differently channel by channel (see Sec. How to use the Settings Tab).

2. Enable the used channels.

3. Adjust the ”Record Length” and ”Pre‐Trigger” to cover the full pulse duration in the waveform plot.
Note that the record length is not used for the charge integration (list mode).

4. Select the proper “Input Range”, which corresponds to the input dynamic range of the digitizer in
order to get all the pulses, even in pile‐up. Possible choices are 0.5, 2 Vpp for 725(S) and 730(S)
family, 1 Vpp and 2 Vpp are the only possibilities for the 751 and 720 (DT5790) families respectively, 2
Vpp is the only possibility for the 2740 family, while the 2730, the 2745 and the 2751 families feature
a Variable Gain Amplifier (VGA) that allows setting the analog gain in dB. The 2730 and 2745 can
achieve gains up to x20 and x100 respectively, starting from a dynamic range of 4 Vpp; the 2751 can
achieve up to x10 starting from a dynamic range of 2 Vpp.
The correct setting of the Input Range is a compromise between the digitizer dynamics saturation and
the use of too few channels of the spectrum. The input range corresponds to the Coarse Gain of the
analog chain.
In our example we choose 2.0 Vpp.

5. Select the input pulse “Polarity” choosing between “Positive” and “Negative”.

6. Adjust the input signal baseline calculation. Both the Threshold parameter, i.e. the trigger threshold,
and the charge integration are referred to the baseline value. CoMPASS provides two options for
setting the baseline:

• Baseline mean calculation, where the DPP‐PSD algorithm calculates online the input signal base‐
line through a mean filter over a number of samples set by the “N sample Baseline” parameter;

• Absolute baseline, where a fixed baseline value is set by the ”Fixed baseline value” parameter.

The usermust choose either one of the twomethods. The plotting of the input signal and the baseline
can help to check the effect of the setting.
The baseline remain frozen for the whole duration of the maximum value between the gate and the
trigger hold‐off parameters. To freeze it for the whole signal width you must adjust the gate and
trigger hold‐off parameters. When choosing the fixed value for the baseline, the baseline remains
frozen for the whole acquisition window.
We choose the first baseline calculation method, i.e. the automatic baseline calculation.
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Fig. 2.57: Waveform plot showing a not proper baseline calculation.

Fig. 2.58: Waveform plot showing a proper baseline calculation.

Note: For 751 series, the baseline freeze lasts for a longer time than the greater value between Long Gate
and Trigger Hold‐off.

7. Adjust the “DC Offset”, i.e. move the baseline level of the input signal upward or downward in the
dynamic scale to cover the full width of the pulse itself, thus avoiding saturation. It is usually recom‐
mended to move the baseline upward for negative pulse, downward for positive signals. Mid‐scale
are fine for bipolar signals, or for small pulses. In case of saturation (both in the upper or lower limit)
the algorithm stops any calculation. In our example we set DC Offset = 70%.

8. It is also possible to calibrate the DC Offset following the Wizard steps (refer to [20]).
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Note: Make sure that no input is connected to the channels.

Note: The DC Offset calibration parameters are saved into the project, so every time the project is opened
the calibration is reloaded. For a new project it is required to perform the calibration for the first time.
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9. Enable the ”Calib ADC” (x725, x730 and x751 only) to make CoMPASS calibrating the ADCs of the
digitizer. To have good performances, it is required to leave this option enabled. The ADC calibration
is made at every start run.

The result of these settings is shown in the following figure.

Fig. 2.59: Waveform plot window showing the effect of changing the Input settings.

It is now possible to set the trigger threshold, which in our case is defined as the relative absolute value of
the trigger threshold with respect to the baseline (see next Section).

Note: When adjusting the DC Offset of a digitizer the user should keep in mind that the digitized samples
are represented in a 0‐(2Nbit) LSB (least significant bit) scale (when Nbit is the number of bit of the digitizer
ADC) but the digitizer input dynamic range scale is not calibrated and cannot be used as a reference for
absolutemeasurements like a standard oscilloscope but just for relative ones (e.g. counting, timing, energy
discrimination).
The 0‐Volt level of the input signal does not correspond to the 0 in the ADC scale. The conversion from
LSB to Volt (1 LSB = (Input dynamic range in Vpp)/2Nbit) could be useful to check the relative difference
between consecutive samples, but theremight be small discrepancies between the ”real” signal amplitude
and what is observed in the waveform plot. In addition, there are also small differences in the DC offset
among each channel: in absence of input signals and for a fixed DAC value programmed, the same value on
each channel, fewmV discrepancy are expected because of various effects, such as tolerances in offset and
gain of the DACs regulating the DC Offset on the input stage of the ADCs, as there’s not internal calibration
(HW calibration) for that. A compensation for such effects can be done in the software if required.

Note: (V17xx, N67xx, DT57xx only) In CoMPASS the digitizer DC Offset can be calibrated with the dedicated
Wizard. After such calibration, setting the same DC offset value in all the digitizer channel allows to have
the baseline level in all of them.

Note: V27xx digitizer input dynamic range scale is calibrated and so can be used as a reference for absolute
measurements like a standard oscilloscope.
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2.11.2.2 How to set the Trigger (DPP-PSD and DPP-QDC)

Since the trigger fires at the zero‐crossing of the CFD signal (refer to [20] for further details) first enable the
visualization of the:

• “Input”
• “CFD”

Select the tab “Discriminator” from the “Settings” window.

Fig. 2.60: Discriminator subtab (DPP‐PSD)

Fig. 2.61: “Discriminator” tab settings and the visualization of the CFD settings and corresponding effect on the signal
inspector window.

Note: DPP‐QDC firmware does not feature CFD discriminator but Leading Edge only.
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1. Start by setting the “Discriminator Mode” to Leading Edge or CFD (in our example it is CFD).
2. Set the CFD parameters, CFD fraction and CFD Delay value (see [20] for further details) in order to

have a steep shape in the zero crossing region. Fraction is usually set to 25% Try to avoid cases where
the “CFD Delay” is too long or too short which are represented in the following figure. On the left the
value is underestimated, on the right it is overestimated.

Fig. 2.62: Two examples where the “CFD delay” is not correctly set. In the left the value is underestimated, on the right
it is overestimated.

The correct value for our example is 12 ns.

Fig. 2.63: Set the CFD Delay to have the a steep shape in the zero crossing region.

3. Set the “Input Smoothing” factor to 2. When the signal presents high frequency noise or fast spikes,
it is convenient to smooth it before processing the trigger. Higher values are needed in case of signal
coming from noisy detectors.

4. The “Trigger Hold‐Off” enables a time window after the trigger, where any other triggers are in‐
hibited. Make sure to set the proper value of the Trigger Hold‐Off according to your signal width,
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especially in case of high frequency signals. Check the correct value by enabling the visualization of
the “Trigger Hold‐Off” trace. The Trigger Hold‐Off goes in steps of 8 ns (all boards except 725 ‐ 16 ns
‐ and 724/781/780/V1782 ‐ 80 ns). We set the Trigger Hold‐Off value to 512 ns.

Note: The ”trigger hold‐off” detects the self‐trigger generated by the channel. It does not detect trigger
signals coming from the TRG‐IN connector or from the Global Trigger configuration.

Fig. 2.64: Set the value of the Trigger Hold‐Off according to your signal width, especially in case of high frequency
signals

5. Set the “Threshold” value to avoid the noise level of the CFD signal.

To correctly set the Threshold value, open the “Energy Histogram” window pressing the button

Zoom in in the lowest region of the spectrum and reduce the threshold level until you get a peak close
to zero. You are now triggering below the noise level. Set then a value slightly higher to trigger on
real pulses.

Note: According to the detector conditions it is possible to have particularly noisy input signals. In this case
the lower region of the spectrum is cut off. To overcome this issue set a greater value of CFD smoothing
to use a greater number of sample for the CFD signal. In this way high frequency noise will be significantly
reduced.
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Fig. 2.65: Low energy region of the energy spectrum. The noise peak is clearly visible on the leftmost region.

In our example, we can reach up to about 10 keV.

Fig. 2.66: Low energy region of the energy spectrum. Increasing the threshold value the noise peak disappears.

2.11.2.3 How to set the Energy and PSD Filter (DPP-PSD and DPP-QDC)

The precise configuration of the Energy and PSD Filter strongly affects the final resolution and the PSD
capabilities of the measurement; therefore it is very important to fine tuning the ”QDC” sub tab settings.
The user must take care of the proper size of the two integration gates, Gate and Short Gate and of the
Pre‐Gate so that no portion of the input signal is lost.
Select the following traces:

• “Input”
• “CFD”
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Fig. 2.67: QDC subtab (DPP‐PSD)

• “Gate”
• “Short Gate”

First adjust the “Pre‐gate” value in the Energy Filter Tab. This value corresponds to the number of ns the
gate will start before the trigger. Indeed the input signal is delayed by the “Pre‐trigger” value, so that the
gate can start before the trigger.
If too short values of the Pre Trigger are set, the firmware automatically adjusts them to the minimum
correct value.

Note: In case of 720 series:
Pre – gate ≤ Pre – trigger – 32ns (2.1)

In case of 751 series
Pre – gate ≤ Pre – trigger – 8ns (2.2)

In case of 740D series
Pre – gate ≤ Pre – trigger – 112ns (2.3)

We set the pre‐gate value to 60 ns.
Setting the “Short Gate” and the “Gate” widths enables the firmware to integrate the input pulse and
calculate the charges Qshort and Qlong. Set the Short Gate and Gate widths to the proper value according
to the input signal. In this example we choose 30 ns for the Short Gate and 300 ns for the Gate.

Note: In case of CFD the pre gate must be set accordingly to the input pulse to make the gate integrate
from the beginning of the signal. It might be possible that pre gate > short/long gate. In case of Leading
Edge Discrimination pre gate < short gate < long gate.

Once the DPP‐PSD parameters have been properly set, it is possible to plot the Energy Histogram of the
gamma‐ray source. For a complete Neutron‐Gamma discrimination, the software allows for a 2D‐plot of
Energy vs PSD. The PSD parameter is calculated as reported in [20].

Note: In the Waves acquisition mode it may happens that a lot of data are processed and transmitted, so
that the Digitizer memory can go full and some data are lost. You can check it through the red “BUSY” LED
on the Digitizer front panel. Usually this happens when you have high frequency input signals, and/or the
“Record Lenght” window is big. Conversely in the List acquisition mode, the overall data throughput of the
Digitizer is significantly reduced since only few data are transmitted (Trigger Time Stamp and Charge), and
the busy state can disappear.

Note: When acquiring in List mode it is recommended to disable the waveforms to avoid data loss. From
the Acquisition window select ”Acquisition: List”.
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2.11.3 DPP-PHA System Parameter Optimization

It is possible to visualize a set of analog and digital traces. Start with the visualization of:

• “Input”
• “Trapezoid‐BL”
• “Trigger”
• “Peaking”

Fig. 2.68: CoMPASS Waveform Plotter window with Input, Trapezoid, Peaking and Trigger traces.

Adjust the record length for a better visualization.
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Note: In case you do not see any signal, select “Auto Trigger” in the Acquisition Tab to enable the software‐
trigger. The software will force the board to trigger the events. Then adjust the channel settings as de‐
scribed in the following sections. Once the parameters are correctly set, unselect the “Auto Trigger” option
to disable the software‐trigger.

Drag and release on the X and Y axes to zoom in a region of the plot.

To zoom out press the button

In the CoMPASS main GUI in the Settings Tab there are several sub‐tabs where all the relevant parameters
are grouped by functionality.

Note: Any time you change one setting always press Enter in your keyboard to apply the setting.

Note: To show/hide one of the traces displayed on the plot, you just have to check/uncheck the tick close
to the corresponding trace.
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2.11.3.1 How to configure the Input Signal settings (DPP-PHA)

The first settings to be configured are those related to the Input Signal.

Fig. 2.69: Input subtab for a x725 and, as comparison, 274x digitizer (DPP‐PHA).

1. Open the ”Input” Tab. You can choose if setting the parameters for all the digitizer channels at the
same time or setting them differently channel by channel (see Sec. How to use the Settings Tab).

2. Enable the used channels.
3. Using themeasurement of the pre‐amplified pulses from an oscilloscope device (refer to Sect. Before

starting the acquisition) it is possible to check what is the pulse height range. It is important to select
the proper “Input Range”, which corresponds to the input dynamic range of the digitizer in order to
get all the pulses, even in pile‐up. Possible choices are 0.3, 1, 3, and 10 Vpp for x781; 0.5, 2 Vpp for 725
and 730 family; x1, x3, x7, x16 for the x780; x1, x2, x4, x8 for the V1782; 0‐40 dB for the 2745 digitizer
family; 0‐29 dB for the 2730 digitizer family; not available for 724 and the 2740 digitizer families. The
correct setting of the Input Range is a compromise between the digitizer dynamics saturation and
the use of too few channels of the spectrum. The input range corresponds to the Coarse Gain of the
analog chain.
In our example we choose the x1 option..

4. Select the input pulse “Polarity” choosing among “Positive” and “Negative”. Since the algorithm
works with positive pulses only, by setting “Negative” the algorithm will invert the digital samples
of the input. The input will always appear as positive in the waveform inspector.

5. Adjust the “DC Offset”, i.e. move the baseline level of the input signal upward or downward in the
dynamic scale to cover the full width of the pulse itself, thus avoiding saturation. Since all pulses will
appear as positive, it is recommended to move the baseline downward in the ADC scale.
We set DC Offset = 20% to have the input signal baseline around 1000 LSB counts. You can safely go
below this value, only check that the input does not saturate around 0. In that case, the algorithm
stops any calculation and increases the dead‐time. It is also important to check that the signal does
not saturate in the upper limit of the dynamics (16k LSB).
The result of these settings is shown in the following figure.

Note: When adjusting the DC Offset of a digitizer the user should keep in mind that the digitized samples
are represented in a 0‐(2Nbit) LSB (least significant bit) scale (when Nbit is the number of bit of the digitizer
ADC) but the digitizer input dynamic range scale is not calibrated and cannot be used as a reference for
absolutemeasurements like a standard oscilloscope but just for relative ones (e.g. counting, timing, energy
discrimination).
The 0‐Volt level of the input signal does not correspond to the 0 in the ADC scale. The conversion from LSB
to Volt (1 LSB = (Input dynamic range in Vpp)/2Nbit) could be useful to check the relative difference between
consecutive samples, but theremight be small discrepancies between the ”real” signal amplitude andwhat
is observed in the waveform plot. In addition, there are also small differences of in the DC offset among
each channel: in absence of input signals and for a fixed DAC value programmed, the same value on each
channel, fewmV discrepancy are expected because of various effects, such as tolerances in offset and gain
of the DACs regulating the DC Offset on the input stage of the ADCs, as there’s not internal calibration (HW
calibration) for that. A compensation for such effects can be done in the software if required.
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Fig. 2.70: “Input Signal” settings and corresponding effect on the waveform plot window.

Note: In CoMPASS the digitizer DC Offset can be calibrated with the dedicated Wizard. After such calibra‐
tion, setting the same DC offset value in all the digitizer channel allows to have the baseline level in all of
them.

2.11.3.2 How to set the RC-CR2 Trigger (DPP-PHA)

Since the trigger fires at the zero‐crossing of the RC‐CR2 signal (refer to [20] for further details) first enable
the visualization of the:

• “Input”
• “RC‐CR2”

Select the tab “Discriminator” from the “Settings” window.

Fig. 2.71: Discriminator subtab (DPP‐PHA)

Note: In the V1782 and in the 27xx family the RC‐CR2 has been replaced by the Triangular filter. Corre‐
spondigly the “Input Rise Time” parameters has been replaced by the “Fast discriminator Rise Time”.

1. Start by setting the “Fast Discriminator Smoothing” factor to 16. All the other settings have to be
tuned according to the smoothing factor (i.e. once you change this value you have to repeat the
whole procedure described in this section).
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Fig. 2.72: “Discriminator” tab settings and the visualization of the RC‐CR2 settings and corresponding effect on the
signal inspector window.

2. Set the “Input Rise Time” value (see [20]. Set the Input Rise time at the same value of the input signal
rise time. Try to avoid cases where the “Input Rise Time” is too short and where the “Input Rise Time”
is too long, which are represented in the following figure. On the left the value is underestimated, on
the right it is overestimated.
The correct value for our example is 0.1 μs.
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Fig. 2.73: Two examples where the “Input Rise Time” is not correctly set. In the left the value is underestimated, on
the right it is overestimated.

Fig. 2.74: Set the Input Rise time at the same vale on the input signal rise time.

3. In case the RC‐CR2 shows an overshoot (see Fig. 2.75), set the “TriggerHold‐Off” value as long enough
to eventually include the overshot inside it. The algorithm then inhibits any trigger occurring during
the whole “Trigger Hold‐Off” duration. Check the correct value by enabling the visualization of the
“Trigger Hold‐Off”.
In case there is no overshoot set the minimum value of Trigger Hold‐Off to cover the RC‐CR2 signal.
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Note: The ”trigger hold‐off” detects the self‐trigger generated by the channel. It does not detect trigger
signals coming from the TRG‐IN connector or from the Global Trigger configuration.

Fig. 2.75: RC‐CR2 signal with an overshoot. Set the Trigger Hold‐Off to cover the overshoot and avoid re‐triggering.

In our example, we set 1.8 μs.

Fig. 2.76: RC‐CR2 signal with no overshoot. Set the Trigger Hold‐Off to cover the RC‐CR2 signal width.

4. Set the “Threshold” value to avoid the noise level of the RC‐CR2 signal. You can visualize the “Thresh‐
old” Analog trace on the Signal Inspector Window.

To correctly set the Threshold value, open the “Energy Histogram” window pressing the button
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Fig. 2.77: RC‐CR2 signal and its threshold. Set the threshold value to avoid the noise level of the RC‐CR2 signal.

Zoom in in the lowest region of the spectrum and reduce the threshold level until you get a peak close
to zero. You are now triggering below the noise level. Set then a value slightly higher to trigger on
real pulses.

Note: According to the detector / pre‐amplifier conditions it is possible to have particu‐
larly noisy input signals. In this case the lower region of the spectrum is cut off. To over‐
come this issue set a greater value of RC‐CR2 smoothing to use a greater number of sam‐
ple for the RC‐CR2 signal. In this way high frequency noise will be significantly reduced.
Remember to adjust again the Input Rise Time and Trigger Hold‐off in case you change the smoothing factor.

In our example, we can reach up to about 10 keV.
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2.11.3.3 How to set the Triangular Filter (DPP-PHA, 2740 and 2745 families only)

Since the trigger fires at the zero‐crossing of the RC‐CR2 signal (refer to [20] for further details) first enable
the visualization of the:

• “Input”
• “Fast Triangle”

Select the tab “Discriminator” from the “Settings” window.

Fig. 2.78: Discriminator subtab for the 2740 and 2745 families (DPP‐PHA)

Choose the desired value of “Timing filter rise time” from a range of 0.08 to 2.0 μs. Set the Threshold
value to avoid the noise level of the fast trigger itself and arm the trigger filter. The trigger will fire on the
derivative signal of the fast trapezoid.
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Fig. 2.79: Signal inspector window for the 2740 and 2745 families with Input signal and Triangular filter .

2.11.3.4 How to set the Trapezoid (DPP-PHA)

The precise configuration of the Trapezoid strongly affects the final resolution measurement; therefore it
is very important to fine tuning the Trapezoid settings.

Fig. 2.80: Trapezoid subtab (DPP‐PHA)

The user must take care of:

• Checking that the trapezoid is correctly shaped;
• Evaluating the energy value (see the Peaking trace) in the flat top region of the trapezoid.

The two typical measurement setups that we are going to discuss are:

1. Low rate (up to few hundreds of Hz) and very high precision measurement;
2. High rate (up to tens of kHz), where the result is a compromise between high resolution and dead‐

time.

Before starting, set the value of “Trap. pole zero”, which corresponds to the input decay time. If the exact
value is unknown set an approximate value. The fine tuning of this parameter is described in Sec. Pole‐Zero
Adjustment.
Select now the following traces:

• “Input”
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• “Trapezoid‐BL”
• “Peaking”
• “Trigger”

Note: The baseline of “Trapezoid ‐ BL” trace should be at 0.

1. In the low rate case it is recommended to set a high value of “Trap. rise time” (Trapezoid rise time),
as for example 6 μs. Considering it in the analogy of the analog chain (refer to [20]) it corresponds to
about 2‐3 μs of shaping time.
Then set a value of “Trap. flat top” (Trapezoid flat top), as for example 1 μs. Check that the flat top
region is really flat. Adjust – if necessary – the Peaking position (“Peaking time”) and the number of
samples (“N sample peak”) for the energymean calculation. Finally for very low rate set themaximum
value of number of samples for the baseline calculation (“N sample baseline”), i.e. 16K (see the Input
tab).

Note: In case of x730 the sum of Trapezoid Rise Time and Flat Top Time should not exceed 8 μs. Suggested
settings for x730 are 6‐7 μs of Rise Time and 1 μs of Flat Top.
In case of x725 the sum should not exceed 16 μs.

Note: In case of x724 and x781 with PHA legacy firmware the Trapezoid Rise Time and Flat Top Time have
a maximum value of about 10 μs. Their sum should not exceed 15 μs.

Note: In case of x724 and x781 and V1782 the Trapezoid Rise Time and Flat Top Time have a maximum
value of about 40 μs. Their sum should not exceed 40 μs.

2. In the high rate case (tens of kHz) it is recommended to set a lower value of “Trap. rise time”, as
for example 3‐4 μs. For a rate greater than 20 kHz it might be convenient to set “Trap. rise time”
= 1 μs. Set also “Trap. flat top” = 1 μs, only check that the flat top region is really flat. Adjust – if
necessary – the Peaking position (“Peaking time”) and the number of samples (“Ns peak”) for the
energy mean calculation in the flat region. Finally decrease the value of number of samples for the
baseline calculation (“Ns baseline”). A dedicated study of the impact of the Ns baseline in the final
resolution can be made.

Both in case of low rate and high rate it is very important to have a flat “Flat Top” region. The “Peaking”,
which corresponds to the samples where the pulse energy is evaluated, should be taken in the flat region.
Adjust the “Peaking time” and the “N sample peak” values accordingly.
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2.11.3.5 Pole-Zero Adjustment

The pole‐zero adjustment is very important for a correct evaluation of the trapezoid baseline and conse‐
quently for a correct evaluation of the energy value. The user must adjust the “Trap. Pole Zero” according
to the Pre‐Amplifier decay time. Fine adjustments can be done looking at the zoom of the Trapezoid trace
(or Trapezoid‐Baseline) in order to have no undershoot nor overshoot. The two cases are shown in the
following figure, where on the left the Trapezoidal Pole Zero has been set too high giving an undershoot,
and on the right the Trapezoidal Pole Zero has been set too low thus giving an overshoot.

When the Pole‐Zero is correctly compensated, the Trapezoid will not make any overshoot nor undershoot.
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2.12 Start/Stop the acquisition and spectra visualization
Once you have configured the acquisition, stop the current run and select the ”List Only” acquisition mode
in the Acquisition Tab.

Then press PLAY to start the acquisition, STOP to stop it.

The acquisition will be started or stopped for all the channels.
Check the readout rate in the ”Statistics” section in the dedicated table in CoMPASSPlot.

Fig. 2.81: Digitizer readout rate.
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To see the energy spectrum, open the “Energy Histogram” window pressing the button

Fig. 2.82: Energy Plot of the 60Co gamma source detected by an HPGe detector and digitizedwith a DT5725 + DPP‐PHA.

Fig. 2.83: Energy Plot of the 60Co gamma source detected by an NaI detector and digitized with a DT5730 + DPP‐PSD.

A box on the left side of the energy histogram summarize the current acquisition statistics: Real, Live and
Dead Time, the total number of Input Counts, the number of counts rejected by the applied selections (if
any) and the total number of Output Counts ie those that passed all the applied selections.

If needed, enable the logarithmic scale by pressing the button
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Fig. 2.84: Energy Plot of the 60Co gamma source detected by a HPGe detector and digitized with a DT5725 + DPP‐PHA.
Log Scale.

Fig. 2.85: Energy Plot of the 60Co gamma source detected by a NaI detector and digitized with a DT5730 + DPP‐PSD.
Log Scale.

To zoom in a specific area press the mouse left button on the histogram axis and drag the mouse cursor.

To unzoom press the button

To freeze the spectrum update press the button

GD6300 ‐ CoMPASS Quick Start Guide rev. 26 79



To reset the spectrum press the button

To see the PSD spectrum (DPP‐PSD only), open the “PSD Histogram” window pressing the button

Select the channel to be displayed into the Source combo box.

Fig. 2.86: PSD spectrum.
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To see the 2‐D scatterplot spectrum (DPP‐PSD only), open the “Scatterplot” window pressing the button

Select the channel to be displayed into the Source combo box.

Fig. 2.87: Two dimensional PSD vs Energy scatterplot.

To see the single channel interval distribution spectrum, open the “Time Histrogram” window pressing the

button

Fig. 2.88: Single channel interval distribution.

Select the channel to be displayed into the Source combo box.
Time correlation between channels can be enabled in the ”Time Selection” tab (for more information see
[20]). On‐board coincidences can be enabled through the ”Onboard coincidences” tab (refer to [20] for
more details):
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1. Paired AND: the software correlates the digitizer channels n and n+1, i.e. Ch0 with Ch1, Ch2 with Ch3
and so on by evaluating the time difference TChn+1 ‐ TChn;

2. Ch_ref AND any: it corresponds to the option Common Start in the traditional analog electronics
with TDCs. One channels is meant to provide the reference time (Tstart) while all the others will be
the evaluated with respect to it (Tstop). The user must specify the reference channel in the Starting
channel field. The width of the correlation window (in μs) has to be specified in the Correlation
window field.

3. Ch_ref veto: the reference channel acts as a veto for the other channels. Filtered events have a time
difference with respect to the reference channel greater than the correlation window. The user must
specify the reference channel in the Starting channel field. The width of the correlation window (in
μs) has to be specified in the Correlation window field.

4. Bd_ref veto: the reference board acts as a veto for the other boards. The veto signal is the logical OR
of the reference board channels signal. The veto width (in μs) has to be specified in the Correlation
window field.

TheΔt, E vs E,Δt vs E plots become available onlywhen the time correlation between channels are enabled.
Depending on which kind of time correlation the user has selected, the same will be applied to these plot
andwill affectwhich channels will be displayed: channel n and n+1 in case of ”Paired AND”, refence channel
and one of the others (according to the user choice) in case of ”CH_ref AND any”.
To see the Δt between two channels distribution spectrum, open the “Tof Histogram” window by pressing

the button

Fig. 2.89: Time difference between channel n and n+1.
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To see the 2D Energy vs Energy between two channels distribution spectrum, open the “E vs E Histogram”

window by pressing the button

Fig. 2.90: E vs E distribution between channel n and n+1.

To see the 2D Δt vs Energy between two channels distribution spectrum, open the “E vs E Histogram”

window by pressing the button

Fig. 2.91: E vs E distribution between channel n and n+1.
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Note: To change the spectra limits and number of channels select the ”Spectra” tab.

To see the Multi Channel Scaler (MCS) graph pressing the button

Fig. 2.92: Multi Channel Scaler graph.

The Graph shows the cps vs time for the raw, unfiltered and filtered data (see Sec. How to set Energy, PSD
and Time selections for more details). In order to set the MCS graph properties the user have to open the

”Settings” sub‐window by pressing the
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Fig. 2.93: Multi Channel Scaler graph settings.

The user can set the MCS graph Dwell time (in seconds), MCS X Axis mode (”Time interval (s) or ”Most
recent (s)”) and MCS view mode (”cps vs time” or ”cps histogram”).

Fig. 2.94: Multi Channel Scaler histogram.
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2.13 How to Calibrate the Spectrum
The software allows the user to calibrate a spectrum from counts to keV/MeV using two interpolating
functions: Linear and Quadratic. For the first function, the user must define at least a couple of values,
while for the second the user must define at least three values. It is also possible to define more points;
the algorithm will then compute the best fit of the defined points.
The user can select a Region of Interest (ROI) of the spectrum and take the mean value of the distribution
for the energy calibration.

2.13.1 How to select a ROI

Open the ROI management window by pressing the and selecting ”ROI” .
The following tab will appear on the bottom side of the spectrum window.

Fig. 2.95: ROIs management tab.

Zoom in (drag and release the mouse to zoom in) in the spectrum region of the relevant peaks to select
the ROI.

Click on the ”Add” button or right click on the plot to add a new ROI, then left click on the histogram to
select the left limit of the ROI then drag and right click to define the ROI right limit.

Fig. 2.96: ROI limits setting for the first peak.
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The ROI limits will be automatically written in the ROI tab.

Repeat the same procedure for the second peak:

Fig. 2.97: ROI limits setting for the second peak.

Select the background type you want to be used for the peak fit (Linear or Quadratic + Step Function).
CoMPASS will then automatically fit the peak and evaluate the peak centroid, sigma, FWHM, FWTM, fit χ2,
resolution percentage, gross counts, net counts and background counts. All the analysis results are then
reported in the ROI management tab.

Fig. 2.98: ROIs analysis results.

If the option ”No Fit” is chosen, CoMPASS will evaluate the histogram centroid, sigma, FWHM, FWTM,
percentage resolution and gross counts only.
Press on the Save button to Save the single plot ROIs (”Save”) or the whole project ROIs, i.e. the ROIs of all
the spectra of all the channels (”Save project ROIs”).
Press on the Load button to Load from an external file the single plot ROIs (”Load”) or the whole project
ROIs ie the ROIs of all the spectra of all the channels (”Load project ROIs”).
Press on the ”Export to channels” to export the current plot ROIs to the corresponding plots of the other
channels.
The results of the ROIs definition and analysis are saved into the run folder at the end of the acquisition in
a text file.
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Fig. 2.99: ROIs export panel.

2.13.2 Calibration Procedure

Open “Calibration Setup” window by pressing the button

Fig. 2.100: CoMPASS Spectrum Energy Calibration Window.

1. Select the calibration Type (Linear or Quadratic) and the Energy Units in which the energy spectrum
will be calibrated (keV or MeV)
• Linear calibration is according to the formula

Energy = C0 + C1× Channel (2.4)

• Quadratic calibration is according to the formula

Energy = C0 + C1× Channel + C2× Channel2 (2.5)
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2. Zoom on the histogram area in which the peak you want to use as a calibration point is present. Left
click on the peak centroid to enter its value into the ”ADC Channel” field or write it explicitly

3. Click on the Add button
4. Repeat the points 2 and 3 including at least 2 calibration points in case of the Linear calibration or at

least 3 points in case of Quadratic calibration

Fig. 2.101: CoMPASS Spectrum Energy Calibration Procedure.
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or alternatively press the button ”From ROIs” to automatically import the ROIs centroid and then
writing the corresponding energy value.

Fig. 2.102: CoMPASS Spectrum Energy Calibration Window (Calibration points imported from ROIs).

5. Click on the checkbox ”Use” if you want to select/remove one or more calibration point
6. Press ”Export” to export on an external file the calibration points and coefficient
7. Press ”Import” to import from an external file the calibration points and coefficient

Click on the ”View fit” tick in order to open the spectrum fit plot.

Fig. 2.103: Calibration Fit.
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To apply the calibration press the ”Calibrate” button

Note: Once the calibration is applied, the calibration parameters C0, C1, C2 are saved into the run.info file
contained in the project folder under the path ”DAQ\run”.

Fig. 2.104: CoMPASS calibrated Energy Spectrum.

GD6300 ‐ CoMPASS Quick Start Guide rev. 26 91



2.14 How to Fit the Spectrum
The software allows the user to fit the spectrum peaks with the desired fitting function.

In order to fit a peak freeze the spectrum update pressing the button

Zoom into the desired area by pressing the mouse left button and the histogram axis and dragging the
mouse cursor.

Open the fit panel pressing the button

Fig. 2.105: CoMPASS Fit Panel.

Set the fit function, the fit limits, the desired option to enable and press ”Fit”.

92 GD6300 ‐ CoMPASS Quick Start Guide rev. 26



Fig. 2.106: Energy Peak Fit.

Once finished, close the Fit panel and press the Fit button . At this point the freeze button
becomes available; click it to let the plot run again.
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2.15 How to set Energy, PSD and Time selections
The CoMPASS Software allows the user to set data selections on the Energy, PSD, Scatterplot and Time
histogram. The data selection can involve one or more quantities at the same time. There are two ways of
setting and applying the data selection:

Directly on the plot by pressing the button

1.

Fig. 2.107: Energy cut definition procedure using the plotter.

A cursor will then become available and the user have to click on the histogram points that will be
the ”Low Cut” and ”High Cut”.

Note: In the case of a Time Histogram, only a ”Low Cut” can be applied.

To apply the cut the user have to press the button

2. Through the main GUI select in the ”Rejections” tab the cut to be applied in each spectrum.

When the cut on a quantity has been applied, in the corresponding histogram an additional combo box
(”Dataset”) will appear allowing the user to select the data to display:

• ”Unfiltered” data, before the cut
• ”Filtered” data, after the cut
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Fig. 2.108: Unfiltered (top) and filtered (bottom) data in the energy histogram.

The user can also apply a two dimensional cut on the Energy‐PSD, Energy vs Energy and ΔT vs Energy
scatterplot.
The user has first to define the PSD cut and then the Energy one clicking inside the scatterplot.
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Fig. 2.109: Two dimensional cut selection.

Fig. 2.110: PSD cut definition of the Energy‐PSD scatterplot.
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Fig. 2.111: Energy cut definition of the Energy‐PSD scatterplot.

The results of the selection is shown in the following picture.
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2.16 How to create and use Virtual Channels (Add-back)
Users that operate with segmented detector (like Clover detectors) or need to do an Event Building oper‐
ation can do the job using the Virtual Channel Tab.

Fig. 2.112: CoMPASS Virtual Channels Tab.

Note: Before proceeding with the event building make the energy calibration of the individual channels to
perform the correct energy summing.

The ”Virtual Channel list” section allows the user the possibility to create multiple virtual channels by click‐
ing on the ”+” symbol. They are displayed as tabs. Each of these tabs displays all the available dpp chan‐
nels of the connected boards. The user may combine the desired channels by selecting the corresponding
boxes. The multiplicity of the participating channels and the width of the event building time window (in
ns) can be declared at the ”Event building condition” section. For a selection of n number of dpp channels
and m (m≤ n) multiplicity, an add‐back event will be built if there are hits from minimum m channels.

Fig. 2.113: Virtual Channels Tab ‐ Event building condition section.

The created virtual channel will contain the summed energy of the selected dpp channels. The time‐stamp
of the built events is the average of the single events time‐stamps. No filters can be applied on the virtual
channel events because they are already filtered according to the same selection set for the events coming
from the single channels, i.e. an event discarded by the energy/PSD/time/correlation filter applied in the
single channels is not used in the event building procedure.

In the ”Virtual channel settings” section select the number of channels and the limits of all the spectra that
you are interested to display.
The Add back energy spectrum shows a number of bins equal to the sum of the single spectra bins.
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Fig. 2.114: Virtual Channels Tab ‐ Virtual channel settings section

The Virtual channels calibration is a two‐step procedure:

• first you have to perform the energy calibration of all the channels involved in the Add back building
according to the procedure explained in Sec. Calibration Procedure.

Fig. 2.115: Virtual channels calibration ‐ first step.

• finally perform the Add back energy spectrum calibration as per the procedure explained in Sec. Cal‐
ibration Procedure
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Fig. 2.116: Virtual channels calibration ‐ second step.

The Add back calibration parameters are shown in the ”Virtual channel calibration” section.

Fig. 2.117: Virtual channel calibration section.

When the data acquisition is running one can check theVirtual Channel ICR andOCR in the statisticswindow
of CoMPASSPlot.

Fig. 2.118: Virtual channel statistics.

2.17 How to Save the Data
It is possible to save data in different ways:

1. Save the board data buffers data
2. Save the Energy, Time, PSD, ΔT and MCS spectra
3. Save the 2D PSD vs E, E vs E and ΔT vs E spectra
4. Save the list of Trigger Time Stamp, Energy, PSD and possibly waveform for each event
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5. Save a picture of the Energy, PSD, Time, ΔT, Waveforms and 2D spectrum

Select the run name and tick the ”Auto increment” box to increase the run index at every start acquisition.

All saved files are available in the project folder, under the ”DAQ\run” sub‐folder. For each run, run.info
and settings.xml files are saved, reporting general run information and the board settings respectively.

2.17.1 Save the board data buffer file

In order to save the board data buffer file the user must select the ”Save boards data duffer” option tick
into the Board buffers saving section of the Acquisition Tab.

The board data buffer file is saved into a proprietary file format and can be processed again performing an
offline run where the user can run again the full acquisition possibly setting different data selection.

2.17.2 Save the list of Trigger Time Stamp, Energy, PSD and wave-
forms

In order to save a list file in which the Trigger Time Stamp, Energy, PSD and possibly waveform samples
information are included, the user must select the ”Save raw data” and/or ”Save unfiltered data” and/or
the ”Save filtered data” tick into the List Saving section of the Acquisition Tab:

1. Raw data correspond to all the events acquired by the digitizer including pile‐up and saturation
events. Raw data are useful if the user would like to evaluate the acquistion dead time by his/her
own (see Sec. Dead time evaluation in CoMPASS).

2. Unfiltered data correspond to the events acquired by the digitizer excluding pile‐up and saturation
events

3. Filtered data correspond to the events that passed the filters in the ”Rejection” tab of the Settings
window and in the Time Selection tab (if any).

4. Save event building data (this option is currently unavailable).
5. Save master trigger data (this option is currently unavailable).

Per each of the above kind of data, the user has two possible choices:

1. save one file per each enabled channel: the file is generated for filtered and/or unfiltered data under
the path ”DAQ\run\RAW/FILTERED/UNFILTERED”.

2. save one single file in which the data from all the enabled channels are included: the file is generated
for filtered and/or unfiltered data under the path ”DAQ\run\RAW/FILTERED/UNFILTERED”. This single
file can be time ordered if the option ”Time sorting” is selected.

The energy information can be saved in ADC channel, keV/MeV (in case of energy calibration), or both.
The user can also customize the maximum size of the list chunk file. As soon as the set size is reached,
CoMPASS will automatically close the chunked file and open a new one.
The available file formats are root (.root), Comma Separated Values (.csv) and Binary (.bin).
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1. In case of .root format, a TTree is generated with all the information. The TTree name is ”Data” and
it contains the following TBranches:

• Channel (Short)
• Timestamp (Long Long Int)
• Board (Short)
• Energy (Short)
• EnergyShort (DPP‐PSD case only) (Short)
• Flags (Integer)
• Probe (Integer)
• Samples (if enabled) (TArrayS)

2. In case of .csv format, the first row indicates the meaning of the subsequent values, which are:
• PSD (+ waveform) = Time stamp, Energy, Energy short, Flags, (samples);
• PHA (+ waveform) = Time stamp, Energy, Flags, (samples).

Note: The time stamp is expressed in ps and it has the following limits for all the supported digitizer families:
[0,264] ps.

3. In case of .bin format, the output file is represented as follows:
Header (16 bit, 0xCAEx)
Board (int, 16 bit)
Channel (int, 16 bit)

Time Stamp (ps) (int, 64 bit)
if bit 0 of the Header is 1:

Energy (ch) (int, 16 bit)
if bit 1 of the Header is 1:

Energy (keV/MeV) (double, 64 bit)
if both bit 0 and of the Header are 1:

Energy (ch) (int, 16 bit) + Energy (keV/MeV) (double, 64 bit)
if bit 2 of the Header is 1, the following field is present:

Energy Short (ch) (int, 16 bit)

Flags (bit‐by‐bit, 32 bit)
if bit 3 of the Header is 1, the following fields are present:

Waveform code (int, 8 bit)
Number of Wave samples to be read (int, 32 bit)

Sample1 ... SampleN (int, 16 bit each)

Note: In the .bin format, the Header is present just once at the beginning of the file and not in each event.

The x in the Header is:
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• bit 0: if 1, Energy in Channels is present
• bit 1: if 1 ,Energy in KeV/MeV (according to the calibration) is present
• bit 2: if 1, Energy short is present
• bit 3: if 1, Waveform samples are present

Waveform codes are listed below:
1 Input
2 RC‐CR (DPP‐PHA firmware only)
3 RC‐CR2 (DPP‐PHA firmware only)
4 Trapezoid (DPP‐PHA firmware only)
5 Baseline
6 Threshold
7 CFD (DPP‐PSD firmware only)
8 Trapezoid‐Baseline (DPP‐PHA firmware only)
33 Fast Triangle (x27xx DPP‐PHA firmware only)
41 Smoothed Input (DPP‐PSD firmware only)

Flags are listed below:
0x1 A dead‐time is occurred before this event (includes input stage saturation and board

memory full conditions. x724 family DPP‐PHA firmware release < 128.64 only.)
0x2 Time stamp roll‐over
0x4 Time stamp reset from external
0x8 Fake event
0x10 A memory full is occurred before this event
0x20 A trigger lost is occurred before this event
0x40 N triggers have been lost (N can be set through bits[17:16] of register 0x1n84 in case of

x725 and x730 family [RD21] or through bits[17:16] of register 0x1nA0 in case of x724, x780,
x781 and V1782 family [RD22][RD23])

0x80 The event is saturating inside the gate (DPP‐PSD) ‐ The trapezoid is saturating (DPP‐PHA)
0x100 1024 triggers have been counted
0x200 First event after a board busy condition
0x400 The input is saturating
0x800 N triggers have been counted (N can be set through bits[17:16] of register 0x1n84 in case of x725

and x730 family [RD21] or through bits[17:16] of register 0x1nA0 in case of x724, x780, x781 and
V1782 family [RD22][RD23])

0x1000 Event not matched in the time correlation filter
0x4000 Event with fine time stamp
0x8000 Piled‐up event
0x80000 Identifies a fake event reporting a PLL lock loss
0x100000 Identifies a fake event reporting an over‐temperature condition
0x200000 Identifies a fake event reporting an ADC shutdown

Note: Whenmore than one of the listed condition applies to the same event, flags do sum up. For example
a pile‐up event in which input has saturated will be flagged as 0x8000 (pile‐up event) + 0x400 (input is
saturating), so flag will be 0x8400.

Note: In digitizers of generation 1.0, the Fine TimeStamp calculation is not always performed; it depends
on the board model and the firmware type. Therefore, the flag is raised only when the calculation occurs.
In digitizers of generation 2.0, instead, the Fine TimeStamp calculation is always performed; consequently,
the flag is raised only when it is considered reliable.

Here an example of how to read a binary list file in case of DPP‐PSD (enabled options: ADC Channel and
waveform with 56 samples):
where the colors correspond to:

• black = header = 0xCAED→ Energy is in channels, Energy short and samples are present
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• green = board = 0
• orange = channel = 0
• light blue= time stamp = 0x4A0B1209 = 1242239497 (dec) ps
• purple = ELong = 0xEF = 239 ch
• brown = Eshort = 0x32 = 50 ch
• red = flags
• yellow = number of samples = 0x38 = 56 (dec)
• pink = wave samples

After 56 samples data start again from board, channel, etc...

The user has also the possibility to access the filtered list files generated by CoMPASS through a socket
and redirect them directly to his/her own post‐processing code. The user just need to select the ”Filtered
time‐sorted binary data through socket” to access this functionality. In the CoMPASS installation folder
under the path

”C:\CoMPASS\demo” in Windows

and
”/CoMPASS‐vX.Y.Z/demo in Linux”

a C++ demo code allowing the user to access the data through the socket is provided. The user can write
his/her own code starting from this demo code.
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The TCP/IP port used by CoMPASS can be set by the user. In case this port is already used by any other
process, CoMPASS will display a warning message. If the port 0 is selected, once the socket is started, the
Port Selection panel will be updated with the choosen port. The user can compile and execute the demo
code using CMake and the CMakeLists.txt file in the demo folder. Following the structure of the packet
sent through data socket:

Header (64 bit)
Event 0:

Board (int, 16 bit)

Channel (int, 16 bit)

Time Stamp (ps) (int, 64 bit)

if bit 0 of the Header is 1:
Energy (ch) (int, 16 bit)

if bit 1 of the Header is 1:
Energy (keV/MeV) (double, 64 bit)

if both bit 0 and of the Header are 1:
Energy (ch) (int, 16 bit) + Energy (keV/MeV) (double, 64 bit)

if bit 2 of the Header is 1, the following field is present:

Energy Short (ch) (int, 16 bit)

Flags (bit‐by‐bit, 32 bit)

if bit 3 of the Header is 1, the following fields are present:

Waveform code (int, 8 bit)

Number of Wave samples to be read (int, 32 bit)

Sample1 ... SampleN (int, 16 bit each)
Event 1:

Board (int, 16 bit)
...
The header is structured as follow:

Fixed word (16 bit, 0xCAEx)

Payload Type (uint, 16 bit)

Packet Size (uint, 32 bit)
The x in the Header is:

• bit 0: if 1, Energy in Channels is present
• bit 1: if 1 ,Energy in KeV/MeV (according to the calibration) is present
• bit 2: if 1, Energy short is present
• bit 3: if 1, Waveform samples are present

The payload type is fixed to be 0x0. The packet size is referred to the size of the event section only, ignoring
the header size.
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2.17.3 Save the spectra

All the spectra can be saved choosing between two options:

• save selected spectra at the end of the run;
• save selected spectra periodically, with a programmable period (minimum is 0.1 s).

Both options can be checked together.
The available file formats are:

1. Energy spectrum

• Single column spectrum (.txt)
• 3 column spectrum (.txt3)
• ANSI/IEEE N42.42 spectrum (.n42)
• PC‐Toolkit spectrum (.tka)
• IEC 1455 spectrum (.iec)
• IAEA spectrum data file (.spe)
• JSON

2. PSD spectrum

• Single column spectrum (.txt)
• JSON

3. Time distribution spectrum

• Single column spectrum (.txt)
• 3 column spectrum (.txt3)
• JSON

4. ΔT spectrum
• Single column spectrum (.txt)
• 3 column spectrum (.txt3)
• JSON

5. 2D PSD vs E spectrum

• Comma Separated Values (.csv)
• JSON

6. 2D E vs E spectrum

• Comma Separated Values (.csv)
• JSON

7. 2D ToF vs E spectrum

• Comma Separated Values (.csv)
• JSON

8. MCS spectrum

• Comma Separated Values (.csv)

In the Energy three columns text file the order of the columns is: channel number, counts, energy (given
as low edge of the calibrated histogram bin) and it includes the calibration parameters and the Real/Live
time information.
In the Time distribution three columns text file the order of the columns is: channel number, counts, time
value (given as low edge of the histogram bin) and it includes Real/Live time information.
In the ΔT three columns text file the order of the columns is: channel number, counts, ΔT (given as low
edge of the histogram bin) and it includes the Real/Live time information.
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It is also possible, selecting the related option, to save all the spectrum in a single ROOT file.
Onefile for each enabled channel is generated for filtered and/or unfiltered spectra under the path ”DAQ\run
\FILTERED/UNFILTERED”. If no cuts are applied to the spectrum, only the unfiltered one is saved.

The user can also save a spectrum ”on the fly” by pressing the in the plot window. The spectrum is
saved under the path ”DAQ\run\UNFILTERED” or ”DAQ\run\FILTERED” according to the format specified
in the Acquisition Tab ‐ Spectra Saving section.

GD6300 ‐ CoMPASS Quick Start Guide rev. 26 107



2.17.4 Save an image of the energy, PSD, time, ΔT 2D spectrum and
MCS graph

In order to save a picture of the energy, PSD, time and 2D spectrum, the user must press the button

in the plot window. The picture is saved in the .png format under the path ”DAQ\run\SCREENSHOTS”.

2.17.5 The run_name_info.txt file

At the end of each run, CoMPASS automatically saves a text file in which several useful information about
the just completed run are included. The name of this file is the same as the run name (so it can be
customized changing the run name in the Acquisition tab) to which a ”_info” suffix is added.
Such file includes the following infomation:

• the run ID
• the run start date and time
• the run stop date and time
• channel by channel:

– Energy calibration coefficients and units;
– Real time as hh:mm:ss.000;
– Live time as hh:mm:ss.000;
– Dead time as percentage;
– Input counts and average rate (cps);
– Pile up counts and average rate (cps);
– Saturation counts and average rate (cps);
– E cut (events rejected because of energy selection) counts and average rate (cps);
– PSD cut (events rejected because of PSD selection) count sand average rate (cps);
– T cut (events rejected because of time selection) counts and average rate (cps);
– Singles (events rejected because notmatching the time correlation selection) counts and average

rate (cps);
– Output counts and average rate (cps);
– (DPP‐PSD only) ”Particle 1 name” (events tagged as ”Particle 1 name”) counts and average rate

(cps). ”Particle 1 name” can be specified by the user in the Particle ID tab;
– (DPP‐PSD only) ”Particle 2 name” (events tagged as ”Particle 2 name”) counts and average rate

(cps). ”Particle 2 name” can be specified by the user in the Particle ID tab;

2.17.6 Report generation

CoMPASS allows the user to automatically generate a report of the current run at the end of the acquisi‐
tion. In order to enable this funcionality, before staring the data acquisition run, select from the CoMPASS
main menu Tool→ Preferences. The Preferences popup will appear allowing the user to select the report
generation option.
Report will be generated in PDF format and, for each of the enabled boards and channels will include:

• Board Information
• Run Start/Stop date and time
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• Run statistics information
• Pictures of the spectra

The run report is saved within the specific run folder.
Selecting the option ”Copy run report file to a single folder”, CoMPASS will save all the PDF report files as
well as the TXT run info files within the same folder that currently is
”C:\Users\<USER_NAME>\AppData\Local\Compass\data.
CoMPASS report generation functionality is still preliminary. Report format and content will be improved
in the following releases.
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2.18 How to reprocess the CoMPASS data files
CoMPASS allows the user to reprocess all the files saved during a data taking run, be they a board buffer, a
list file or a spectrum.
As explained in the section Open a CoMPASS Project, when opening a project including data saved in one
or more previous acquisition, in the CoMPASSPlot the Offline data section becomes available. Clicking on
theOffline data, the below sections (Boards data buffer, List, Spectra) becomes available and selecting one
of them the user can check the included data files.

Fig. 2.119: Saved data present in the project folder as displayed in the CoMPASSPlot Window.

2.18.1 How to reprocess the Board data buffer data files

CoMPASS allows the user to re‐run previous acquisitions starting from themost preliminary data
files coming from the digitizer and not even decoded by the software, the so called Board data
buffers. Such data allows to rerun a previously exactly an a normal run except for what concern
the board(s) parameters settings that cannot be modified anymore. The rest of the software
capabilities remains unchanged: the user can display the spectra, apply data selection (see Sec.
How to set Energy, PSD and Time selections) and save new list and spectra files.

The CoMPASS main GUI will reflect the above by disabling all the parameters and setting that
cannot be changed in the current offline condition.

In order to perform a such kind of offline run, you have to select the Board data buffer option,
select the run in the displayed list of runs and then press the Load button or double click on
the run to load it. You can also select the speed of the run reproduction. Default is high speed,
otherwise select Real time playback for reproducing the run at the real speed.
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Fig. 2.120: Offline run ‐ Board data buffer option.

The offline run kind is also reflected in the main GUI status bar

Fig. 2.121: Offline run ‐ Board data buffer option ‐ GUI status bar.

and in the CoMPASSPlot Status bar.

Fig. 2.122: Offline run ‐ Board data buffer option ‐ GUI status bar.

Press Play to start the run. All the functionalities of the CoMPASSPlot (available plots, ROI man‐
agement, calibration, event selection) are available as well as the data saving functionalites.

Note: It is not possible to save an offline data file while performing an Offline run on Board data buffer
files.

While the run is being processed the information about the original run duration and the current
processing time are displayed in the Statistics tab top bar.

Fig. 2.123: Processing time and original online run duration.
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2.18.2 How to reprocess the List data files

CoMPASS allows the user to re‐run previous acquisitions starting from list data files that are the
data coming from the digitizer but already decoded by the software and, depending on which
kind of list file is used (Raw, Unfiltered and Filtered), possibly passed through some kind of se‐
lection.
Besides of being not possible anymore to change the board parameters, depending onwhat kind
of List file is used for the offline processing, some functionalities are not available anymore. For
example:

• Add‐Back and Time correlation are possible only if a single time ordered list file has been
saved

• Raw and Unfiltered list file cannot be saved anymore if the offline processing is done with
an Unfiltered or Filtered list file respectively, i.e. it’s not possible to ”go back” in data saving
as the events that would have been included in the Raw or Unfiltered list file have been
already removed

• It’s not possible to save a single time ordered list file if in the online acquisition the option
”one file per channel” was selected.

The rest of the software capabilities remains unchanged: the user can display the spectra, apply
further data selection (see Sec. How to set Energy, PSD and Time selections) and save new list
and spectra files.

The CoMPASS main GUI will reflect the above by disabling all the parameters and setting that
cannot be changed in the current offline condition.

Fig. 2.124: Offline run ‐ Board data buffer option.

In order to perform a such kind of offline run, you have to select the List option, select the run
in the displayed list of runs and then press the Load button or double click on the run to load it.

Also in this case, the offline run kind is also reflected in the main GUI status bar and and in the
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CoMPASSPlot Status bar.

Press Play to start the run. All the functionalities of the CoMPASSPlot (available plots, ROI man‐
agement, calibration, event selection) are available as well as the data saving functionalities with
the limitation above described.
Also in this case, while the run is being processed the information about the original run duration
and the current processing time are displayed in the Statistics tab top bar.

Fig. 2.125: Processing time and original online run duration.

2.18.3 How to reprocess the Spectra files

CoMPASS allows the user to re‐process any kind of spectra (Energy, PSD, Time and ΔT) taken in a
previous acquisition. When processing a spectrum the spectrum rebin and manually set of the
calibration coefficient are the only settings that will remain settable in the CoMPASS main GUI.
All the others will be disabled.

Fig. 2.126: Offline run ‐ Spectra option.

The procedure to be followed to load a spectrum is similar to the one described here above so
you have to select the Spectra option, select the spectrum in the displayed list and then press
the Load button or double click on the spectrum to load it.

Also in this case, the offline processing kind is also reflected in the main GUI status bar and and
in the CoMPASSPlot Status bar.

The CoMPASSPlot available functionalities are ROI management, calibration and spectrum sub‐
traction.
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2.18.4 How to sum the energy spectra

In order to summore energy spectra created by CoMPASS you have to select File→ Sum energy
spectra.

The Add spectrum selection windows will then appear and you can then select the spectrum to
be added.

Fig. 2.127: Sum spectrum selection window.

CoMPASS will the make a copy of the original spectra and include them in the project‐like folder
structure.

CoMPASS will notify the user in case of possible issues with the spectrum format.
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Fig. 2.128: Example of error in the spectrum import and sum.

In case of no issues, CoMPASS import and sum the spectra in the CoMPASSPlot window and then
you can apply all the CoMPASSPlot tools (ROI management, calibration, spectra subtraction).

Fig. 2.129: Imported and summed spectra.

2.18.5 How to subtract two energy spectra

In order to subtract two energy spectra (eg the background from a main spectrum), you have to

press on the button

A dedicated pop up to select the spectrum to subtract will appear.
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Fig. 2.130: Spectra subtraction popup.

Press the load button to open the spectrum selection window.

Fig. 2.131: Spectrum to be subtracted selection window.

Select the spectrum to subtract and press Open. The selected spectrum path will be then dis‐
played in the dedicated popup.
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Fig. 2.132: Spectra subtraction popup with spectrum to be subtracted path.

If the two spectrum are not compatible in terms of number of channels or calibration coef‐
ficients, CoMPASS will notify the user with a popup and the subtraction operation cannot be
performed.
Otherwise, if not such issue occur CoMPASS will shown in the same plot both the spectrum
normalized one to each other by means the total number of events.

Fig. 2.133: Main and subtrahend spectrum.

You can see separately the original spectrum and the subtrahend one selecting Base Spectrum
or Subtrahend spectrum respectively. Press the button Apply to proceed with the spectrum
subtraction. The resulting spectrum will be then shown in the same window.
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Fig. 2.134: Subtracted spectrum.

On the resulting spectrum you can still apply the CoMPASS ROI management tools for your pre‐
liminary basic analysis.
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2.18.6 How to import a spectrum

In order to import in CoMPASS a spectrum in one of the supported formats, you have to select
File→ Import spectrum.

The Import spectrum selection windows will then appear and you can then select the spectrum
to be imported.

Fig. 2.135: Import spectrum selection window.

If the imported spectrum is a .txt, a .txt3, a .CSV or a JSON file, the ambiguity about its content
has to be removed before importing it; for this reason CoMPASS shows a pop‐up asking the user
which kind of spectrum is going to be imported.
CoMPASS will the make a copy of the original spectrum and include in a project‐like folder struc‐
ture.
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Fig. 2.136: Import spectrum type selection window example.

Fig. 2.137: Another import spectrum type selection window example.

CoMPASS will notify the user in case of possible issues with the spectrum format.

Fig. 2.138: Example of error in the spectrum import. Incompatible calibration coefficient.

Fig. 2.139: Example of error in the spectrum import. Invalid or missing mandatory information.

In case of no issues, CoMPASS import the spectrum in the CoMPASSPlot window and then you
can apply all the CoMPASSPlot tools (ROI management, calibration, spectra subtraction).

Note: Spectrum files not generated by CoMPASS may be imported provided that they are in one for the
format supported by CoMPASS.
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Fig. 2.140: Imported spectrum.

2.18.7 How to import a list

In order to import in CoMPASS a list file in one of the supported formats, you have to select File
→ Import list.

CoMPASSwill themake a copy of the original list file and include in a project‐like folder structure.

CoMPASS will notify the user in case of possible issues with the spectrum format.
In case of no issues, CoMPASS import the list file and allows to run process the list file and to
apply the events rejection criteria (saturations, pile‐up, energy, psd and time selection). If the
imported list file is a single time sorted file, the channel correlation selection and the AddBack
functionality are also available. If the list files includes the waveform sample, the waveform dis‐
play (if running in Waves mode) is available as well. In addition, as in the Import spectrum case,
you can apply all the CoMPASSPlot tools (ROI management, calibration, spectra subtraction).

New list and spectrum files can be saved with some limitation:
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Fig. 2.141: Import list selection window.

Fig. 2.142: Example of error in the list import.

• whenprocessing a RawList, it’s possible save again a Raw list in a different format, Unfiltered
list and Filtered List;

• when processing an Unfiltered List, it’s possible save again an Unfiltered list in a different
format and Filtered List only;

• when processing a Filtered List, it’s possible save again an the same Filtered list in a different
format and Filtered List with more restrictive selection criteria only.
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2.19 How to (remotely) control CoMPASS from com-
mand line or external script

For those users who have the requirement to (remotely) control CoMPASS from an external
script or software, CoMPASS now allows such possibility.
Themandatory requirement is that CoMPASS has to be up and running in the pc connected to the

digitizer(s). Then the user can enable the CoMPASS remote control pressing the button
in the CoMPASSPlot window top ribbon. When such remote control is selected, CoMPASS starts
an internal HTTP server that stays listening for HTTP request coming from the client whatever is
its implementation (C, C++, Java, Python, MATLAB, LabVIEW, ecc).
CoMPASS uses only the HTTP ’GET’ request method among the available ones, and can be con‐
trolled by properly setting the URL path and optionally a query string.
Once the remote control is enabled the user can easily test it with a web browser by typing the
URL with the base path:

http://IP_ADDRESS:8080/compass/

where IP_ADDRESS is the IP Address of the computer in which CoMPASS is running, e.g. lo‐
calhost, 192.168.0.1, etc... The IP_ADDRESS is followed by :8080, which is an example of the
Remote Control port. This port can be configured from the ”Tools” pull‐downmenu in the CoM‐
PASS window by selecting ”Port Selection”:

Note: To make the changes effective, please press ”Set” each time a port is modified.

If the selected port is not available, the softwarewill automatically assign another port to ensure
proper functionality of the features. If the same port is chosen for both Remote Control and
Data Socket, CoMPASS will display an error message to warn the user that this configuration is
not allowed.

Commands can be sent by appending a ’/’ and the command name to the base path of the URL

http://IP_ADDRESS:8080/compass/COMMAND

The list of available commands is:

• START to start the acquisition;
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Fig. 2.143: CoMPASS browser remote control window example.

• STOP to stop the acquisition.

A specific configuration file can be uploaded by appending a query string (beginning with the ’?’
character) to the base path in the URL:

http://IP_ADDRESS:8080/compass?loadConfigFile=file.xml

The same rule applies if the user wants to set acquisition parameters:

http://IP_ADDRESS:8080/compass?PARAMETER_NAME=value

where

• PARAMETER_NAME is the parameter name;
• value is one of the allowed value for that parameter.

The parameters and the corresponding allowed values are:

• runId which is the name of the run;
• timedRunEnabled. Allowed values: TRUE, FALSE;
• autoIncrementRunId. Allowed values: TRUE, FALSE.
• timedRunDuration. Allowed values: integer value corresponding the run duration in sec‐

onds.

It is also possible to set more than one parameter at a time in the query string, with parame‐
ter=value pairs separated by the & character:

http://IP_ADDRESS:8080/compass?PARAMETER_NAME_1=value&PARAMETER_NAME_2=value

The user should avoid to load the configuration file and modify one of the above listed param‐
eters in the same HTTP request because it is not guaranteed the order to the requested imple‐
mentation. It is on the contrary recommended to first load the configuration file in a specific
HTTP request and then, in required, modify the needed parameters in an second HTTP request.

The CoMPASS remote control infrastructure uses some of the standard HTTP response code and
one custom. They are:

• OK_200 = 200;
• FORBIDDEN_403 = 403;
• NOTFOUND_404 = 404;
• INTERNALSERVERERROR_500 = 500;
• NOTIMPLEMENTED_501 = 501;
• CANNOTOVERWRITE_599 = 599.

In order to provide to the users and example of the implementation of an HTTP client, CAEN
provide a C++ based demo code included in the CoMPASS installation folder at the path
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”C:\CoMPASS\demo” in Windows

and

”/CoMPASS‐vX.Y.Z/demo” in Linux.

Such demo uses the libcurl library and shows all the remote control functionalities with some
acquisition examples including recursive acquisitions with the same or different configuration
files and with some pause time between consecutive runs.

Fig. 2.144: CoMPASS remote control demo code output.

Such demo can be the starting point for people willing to develope their external (remote) CoM‐
PASS control in C++ or can be inspiration for those userwilling to develop it in other programming
environment.

Note: The user can download the libcurl library at the link https://curl.se/libcurl/.

Note: After saving the CoMPASS project, if Remote Control is selected, the selection will persist even after
the project is closed and reopened.
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3 Digitizer Synchronization Guide
This chapter will guide the user to synchronize two or more CAEN digitizers running a DPP firmware. The
first section is focused on the VME boards, the second section on the Desktop and NIM boards, the third
section on the new VME27XX and Destop DT57XX boards while the forth section on a mixed system com‐
posed by V17XX and V27XX boards. This document is based on [RD24].

3.1 Synchronization of the VME V17XX digitizers
In the following, one V17XX digitizer acts as the master board while the others act as slaves. The idea is to
lock the clocks of all the digitizers and to propagate the start of run in a daisy chain configuration.
Required software:

• CAEN Toolbox;
• CoMPASS

Phase 1: the clock synchronization:

1. The PLL of master must be reprogrammed to provide in the CLOCK OUT the 50 or 62.5MHz frequency
depending on the slave board.
• Open CAEN Toolbox, select ”Digitizer 1.0”.
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• from the top menu select Device → Connect, insert the digitizer connection parameters and
press Connect.

• if themaster digitizer is a V1720, V1724, V1740D, V1751 or V1782, select Tools→ PLL Editor from
the topmenu. The PLL Editor will open. Press ”Detect” button to detect the currently connected
digitizer.
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– Tick ”Enable clock output” and select the clock output frequency depending on the slave
digitizer model. Set the Clock output delay if required.

– Press ”Save” button to save the PLL .rbf file to the desired location on the pc and close the
PLL editor.

– Press the ”Upgrade PLL” button and select the PLL .rbf file previously generated. CAEN Tool‐
box will automatically start the file upload and the PLL programming. Once the file upload
is completed the following message appears.

– Power off and on the crate to apply the new PLL configuration.
• if the master digitizer is a V1725(S) or a V1730(S) user can follow the same procedure described

here above or press directly the ”Upgrade PLL” button.
– In the browser folder, select the file corresponding to the board model like

”v1725_vcxo500_ref50_pll_out62_5.rbf” and press open.
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– CAEN Toolbox will automatically start the file upload and the PLL programming. Once the
file upload is completed the same previous message appears.

• The PLL of the slave must be reprogrammed to accept in input the 62.5 MHz frequency only
if it is a V1725(S) a V1730(S) or a V1740D. All the other digitizer families are indeed already
programmed to accept in input the 50 MHz frequency. Other digitizer families have to be pro‐
grammed to provide in output the 50 MHz only if they are not the last board of the chain.
– From CAEN Toolbox follow the same procedure above described to connect to the slave

board
– Depending on the digitizer model, proceed with the PLL file generation or selection from the

available list files as described in the above paragraphs.
– Upgrade the PLL firmware into the V17XX.

• Power off the crate.
• Move the DIP switch of the V17XX (slave) from internal to external
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• Connect the A317 cable from the CLOCKOUT connector ofmaster to CLOCK IN connector of slave

• Switch on the crate. The CLOCK IN led of the slave board must be ON; The PLL LOCK led of both
boards must be ON.

• To verify that the two clocks are latched and to measure the delay between them, it is possible
to provide to the TRG OUT connector the clock and check it from an oscilloscope. In CoMPASS,
go into the Sync/Trg tab within each single board Settings Tab and select TRG OUT mode →
Sampling clock

• Connect the TRG OUT connector output of each board to an oscilloscope and the check:
– There is no reciprocal jitter between each other.
– Measure the delay according to the following scheme

• Reprogram the master board with a PLL file with a delay value as closest as possible to the mea‐
sured one.
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Note: In case of a system composed by digitizer of different families and including V1725(S) and V1730(S)
digitizers, it is recommended to put such modules at the end of the chain. They will then receive the 50
MHz reference clock and propagate the 62.5 MHz reference clock to the other V1725(S) and V1730(S).

In case the clock of a slave board has been modified to accept an external clock frequency
different from 50 MHz, when the clock source it set back to the internal one, before using
again the digitizer, the user must remember to program the board PLL again with the default
50 MHz PLL file. Missing such digitizer reprogramming might lead either to the impossibility
for the digitizer to lock the PLL or to a digitizer wrong events timestamp information provision.

Phase 2: the start_acquisition propagation.

1. Connect the TRG OUT connector of master V17XX with TRGIN connector of the first slave V17XX
through a LEMO‐LEMO cable and proceed this way building a daisy chain with all the digitizer belong‐
ing to the system.

2. Open the CoMPASS software and select ”Menu→ Synchronization wizard”. In the second tab, set the
board order
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3. In the third tab, choose one of the available start_acquisition propagation option, for example the
TRGOUT_TRGIN_OUT option:

4. You can adjust the run delay from master to slave by providing a single pulse into the two boards
and check the reported time stamp. This step is not fundamental, the relative delay can be adjusted
offline by software.

The two boards are now synchronized and the customer can start the acquisition by pressing the START
button in CoMPASS.
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3.2 Synchronization of the Desktop DT57XX and NIM
N67XX digitizers
In the following, one DT57XX/N67XX digitizers acts as the master board while the others act as slaves for
what concern the start_acquistion signal propagation only. The clock signal are, on the contrary distributed
in FAN OUT mode because the DT57XX/N67XX digitizers do not feature the CLK OUT connector. A clock
generator like the DT4700 model is then required in such a configuration.
Required software: CoMPASS only.
Phase 1: the clock synchronization:

1. There is no need to reprogram the digitizer PLL in this case because the DT57XX/N67XX boards are
already configured to work with the 50 MHz input clock. It is just required to configure the digitizer
so that the reference clock is the external one instead on the internal one. This is done automatically
by CoMPASS during the synchronization wizard.

2. There is no need to check the reference clock delay among the boards because the clock is provided
to all the digitizers in FAN OUT mode.

3. Connect the A317 cable from the DT4700 CLOCK OUT connector to the DT57XX/N67XX CLOCK IN
connector.

......

DT57XX
Digitizers

N67XX
Digitzers

DT4700
Clock Generator and Fan Out

A317 Clock
Distribution Cable

A317 Clock
Distribution Cable

Phase 2: the start_acquisition propagation.

1. Connect the GPO OUT connector of master DT57XX/N67XX with TRG IN connector of the first slave
DT57XX/N67XX through a LEMO‐LEMO cable and proceed this way building a daisy chain with all the
digitizer belonging to the system.

2. Open the CoMPASS software and select ”Menu→ Synchronization wizard”. In the second tab, set the
board order
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3. In the third tab, choose one of the available start_acquisition propagation option, for example the
GPO_TRGIN_AUTO option:

4. You can adjust the run delay from master to slave by providing a single pulse into the two boards
and check the reported time stamp. This step is not fundamental, the relative delay can be adjusted
offline by software.

The two boards are now synchronized and the customer can start the acquisition by pressing the START
button in CoMPASS.
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3.3 Synchronization of the VME V27XX and desktop
DT27XX digitizers
In the following, one V27XX/DT57XX digitizer acts as the master board while the others act as slaves. The
idea is to lock the clocks of all the digitizers and to propagate the start of run in a daisy chain configuration.
Required software:

• CoMPASS only

The clock synchronization and the start_acquisition propagation are done together through the CoMPASS
Synchronization Wizard

1. Connect the A319 cable from the CLOCK OUT connector of the master to CLOCK IN connector of slave

Fig. 3.1: V/VX27xx case.

2. There is no need of additional cable connection because the start_acquisition signal is propagated
from the master to the slave(s) by the A319 cable
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Fig. 3.2: DT27xx case.

3. Open the CoMPASS software and select ”Menu→ Synchronization wizard”. In the second tab, set the
board order
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4. In the third tab, choose one of the available start_acquisition propagation option, for example ”CLK
OUT→ CLK IN ‐ Start/stop from software” option:

5. Press Apply to have CoMPASS applying the synchronization settings
6. The CLOCK IN led of the slave board must be ON; the PLL LOCK led of both boards must be ON.
7. You can adjust the run delay from master to slave by providing a single pulse into the two boards

and check the reported time stamp. This step is not fundamental, the relative delay can be adjusted
offline by software.

The two boards are now synchronized and the customer can start the acquisition by pressing the START
button in CoMPASS.
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3.4 Synchronization of the VME V17XX and V/VX/
DT27XX digitizers
When it is required to synchronize a systerm composed by a mixed 17XX and 27XX, the advice is to group
the 17XX and the 27XX digitizer together and to setup the system in order to get the 17XX digitizer as the
firsts in the chain. In this way there will bi a single discontinuity point between the last 17xx and the first
27xx.
In the following, a V17XX digitizer acts as the master board while a V27XX act as slaves. The idea is to lock
the clocks of all the digitizers and to propagate the start of run in a daisy chain configuration.
Required software:

• CAEN Toolbox
• CoMPASS

Phase 1: the clock synchronization:

1. The PLL of the V17xx must be reprogrammed to provide on the CLOCK OUT connector the 62.5 MHz
frequency.

• Open CAEN Toolbox, select ”Digitizer 1.0”.
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• from the top menu select Device → Connect, insert the digitizer connection parameters and
press Connect.

• if the master digitizer is a V1720, V1724, V1740D, V1751 or V1782, select Tools→ PLL Editorfor
V/VX from the top menu. The PLL Editor will open. Press ”Detect” button to detect the currently
connected digitizer.
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– Tick ”Enable clock output” and select the clock output frequency depending on the slave
digitizer model. Set the Clock output delay if required.

– Press ”Save” button to save the PLL .rbf file to the desired location on the pc and close the
PLL editor.

– Press the ”Upgrade PLL” button and select the PLL .rbf file previously generated. CAEN Tool‐
box will automatically start the file upload and the PLL programming. Once the file upload
is completed the following message appears.

– Power off and on the crate to apply the new PLL configuration.
• if the master digitizer is a V1725(S) or a V1730(S) user can follow the same procedure described

here above or press directly the ”Upgrade PLL” button.
– In the browser folder, select the file corresponding to the board model like

”v1725_vcxo500_ref50_pll_out62_5.rbf” and press open.

140 GD6300 ‐ CoMPASS Quick Start Guide rev. 26



– CAEN Toolbox will automatically start the file upload and the PLL programming. Once the
file upload is completed the same previous message appears.

• The PLL of the slave already accept in input the 62.5 MHz clock and it must be programmed to
accept the external clock signal.
– Open the VX27XX/DT27XX Web Interface, select ”Clock Settings”.
– Select Reference clock ”External”, Output clock ”Enable” and press Apply for the slave board
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– Connect the A319B cable from the CLOCK OUT connector of the master to CLOCK IN connec‐
tor of slave

– Switch on the crate. The CLOCK IN led of the slave board must be ON; the PLL LOCK led of
both boards must be ON.

– To verify that the two clocks are latched and to measure the delay between them, it is pos‐
sible to provide to the TRG OUT connector the clock and check it from an oscilloscope. In
CoMPASS, go into the Sync/Trg tabwithin each single board Settings Tab and select TRGOUT
mode→ PLL clock

– Connect the TRG OUT connector output of each board to an oscilloscope and the check:

* There is no reciprocal jitter between each other.

* Measure the delay according to the following scheme
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In case the clock of a V17XX slave board has been modified to accept an external clock fre‐
quency different from 50 MHz, when the clock source it set back to the internal one, before
using again the digitizer, the user must remember to program the board PLL again with the
default 50 MHz PLL file. Missing such digitizer reprogramming might lead either to the impos‐
sibility for the digitizer to lock the PLL or to a digitizer wrong events timestamp information
provision.

Phase 2: the start_acquisition propagation.
(a) All the V17XX possibly present in the chain must be daisy chained with the TRG OUT ‐ S IN con‐

nection. Connect the TRG OUT connector of master V17XX (or the last V17xx slave) with S‐IN
connector of the first slave V27XX through a LEMO‐LEMO cable. The rest of the slaves 27xx (if
any) can be daisy chained simply connectin the CLK‐OUT and CLK‐IN 4 pin connector as explained
in the previous section.

(b) Open the CoMPASS software and select ”Menu → Synchronization wizard”. In the second tab,
select the board order

(c) In the third tab, choose one of the available start_acquisition propagation option, for example
the TRG OUT→ S IN and GPO→ GPI option:
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(d) You can adjust the run delay frommaster to slave by providing a single pulse into the two boards
and check the reported time stamp. This step is not fundamental, the relative delay can be
adjusted offline by software.

The two boards are now synchronized and the customer can start the acquisition by pressing the
START button in CoMPASS.
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3.5 Synchronization of the Desktop DT57XX/NIM
N67XX and DT27XX digitizers
This section may include two kind of operative scenarios:

1. one or more DT27XX and one DT57XX (Case A)
2. one or more DT27XX and more DT57XX (Case B)

In the first case, no additional hardware is required, and the (last) DT27XX acts as the master board while
the DT57XX and the slave one. In the second case a DT4700 Clock Generator is required in order to provide
the 62.5 MHz reference clock to all the digitizers; the (last) DT27XX acts as the master board while the
DT57XX and the slave one for what concern the propagation of the start_acquisition signal only.
Required software:

• VX27XX/DT27XX Web Interface;
• CAEN Toolbox
• CoMPASS

Phase 1: the clock synchronization:

1. In Case A, the PLL of the master must be reprogrammed to provide the CLOCK OUT (62.5 MHz).

• Open the DT27XX Web Interface, select ”Clock Settings”.
• Select Reference clock ”Internal”, Output clock ”Enable” and press Apply for the master board

2. The PLL of the slave must to be reprogrammed to accepts the 62.5 MHz clock. This can be done using
CAEN Toolbox (TO BE IMPLEMENTED)

• Open CAEN Toolbox, select ”Digitizer 1.0”.
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• from the top menu select Device → Connect, insert the digitizer connection parameters and
press Connect.
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• Select Tools→ PLL Editor for DT/NIM from the topmenu. The PLL Editorwill open. Press ”Detect”
button to detect the currently connected digitizer.

– Press ”Change” button to modify the accepted Input clock frequency. Then press ”Ok” to
confirm

– Press ”Save” button to save the PLL .rbf file to the desired location on the pc and close the
PLL editor.

– Press the ”Upgrade PLL” button and select the PLL .rbf file previously generated. CAEN Tool‐
box will automatically start the file upload and the PLL programming. Once the file upload
is completed the following message appears.

– Power off and on the crate to apply the new PLL configuration.

3. Connect the A319B cable from the CLOCK OUT connector of the master to CLOCK IN connector of
slave
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Fig. 3.3: Case A.

4. In Case B, it is required to program the PLL of the DT57XX because by default it accept the 50 MHz
clock only. To perform this operation, follow the instruction detailed for Case A.

5. Connect the A317 cable from the DT4700 CLOCK OUT connector to the DT57XX CLOCK IN connector
and the A319B cable from the DT4700 CLOCK OUT connector to the DT27XX CLOCK IN connector.

...

DT57XX
Digitizers

DT4700
Clock Generator and Fan Out

A317 Clock
Distribution Cable

DT27XX
Digitizers

...

A319B Clock
Distribution Cable

Fig. 3.4: Case B.

6. The CLOCK IN led of the all the board must be ON; the PLL LOCK led of all the boards must be ON.

7. There is no need to check the reference clock delay among the boards because the clock is provided
to all the digitizers in FAN OUT mode.
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In case the clock of a DT57XX/N67XX slave board has beenmodified to accept an external clock
frequency different from 50MHz, when the clock source it set back to the internal one, before
using again the digitizer, the user must remember to program the board PLL again with the
default 50 MHz PLL file. Missing such digitizer reprogramming might lead either to the impos‐
sibility for the digitizer to lock the PLL or to a digitizer wrong events timestamp information
provision.

Phase 2: the start_acquisition propagation.

1. In both Cases A and B Connect the GPIO connector of master (or the last) DT27XX either with the GPI
of the first slave DT57XX through a LEMO‐LEMO cable. The rest of the DT57xx slaves (if any) have to be
daisy chained through the GPO‐GPI connectors. If more DT27xx are included in the system they can
be daisy chained using the CLK OUT ‐ CLK IN connector chain as explained in the dedicated section.

2. Open the CoMPASS software and select ”Menu→ Synchronization wizard”. In the second tab, select
the board order

3. In the third tab, choose one of the available start_acquisition propagation option, for example the
CLK OUT→ CLK IN and GPO→ GPI option.
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4. You can adjust the run delay from master to slave by providing a single pulse into the two boards
and check the reported time stamp. This step is not fundamental, the relative delay can be adjusted
offline by software.

The two boards are now synchronized and the customer can start the acquisition by pressing the START
button in CoMPASS.
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4 Dead time evaluation in CoMPASS
CoMPASS provides a dead time estimation based on the data coming from the board and allows the user
to have access to the same data to evaluate the deadtime by his/her own. CoMPASS indeed allows the
user to save the Raw acquisition data, i.e. including the saturations and pileup events usually not included
in the spectra but required to provide the dead time estimation. The list file includes a column in which
additional information about each event is included and coded in a flag (see Sec. Save the list of Trigger
Time Stamp, Energy, PSD and waveforms).

Note: In case of onboard coincidence, CoMPASS is not able to evaluate the correct dead time, since it
cannot calculate statistics from events that are processed in coincidence directly by the firmware.

4.1 Dead time estimation with the DPP-PSD firmware
The deadtime percentage is estimated by CoMPASS as:

1 –
(output_events + events_discarded_by_user_selection + saturation_events)

input_events
(4.1)

The critical point is how to properly estimate the number of input events. In order to do it, CoMPASS sums
up the following events:

• output events going into the energy spectrum;
• events rejected by user selection, if any;
• events rejected by the software time sorting algorithm;
• events rejected because of the saturation of the digitizer input stage;
• pile up events counted twice because, in case of two overlapping events within the integration gate,

the second one will not have its own trigger and the pile up rejector algorithm will tag only the first
one;

• the so called ”poissonian events”.

The last point goes as follows and it is the sum of two kind of events:

• estimated lost events during the Trigger Hold‐Off time: using a recursive procedure, a Poisson distri‐
bution is generated whose average value λ is the ICR× Trigger Hold‐Off time.

P(n_events_lost_during_THO) =
λn
n!

e–λ (4.2)

where λ = ICR× Trigger Hold‐Off.
The starting point is the first ICR and then with a recursive procedure improves the estimation at each
iteration;

• estimated lost events during a memory full condition: when an event is tagged with thememory full
flag (0x10) the softwaredoes a smallMontecarlo simulation inwhich it emulates a Poissondistribution
whose average value is the ICR×Memory Full time. The time interval used for this simulation is the
difference between the timestamp of the events tagged with thememory full flag and the last event
without this flag.
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Note: in the DPP‐PSD firmware case, no estimation of lost events during the saturation of the input stage
is performed. This is due to the fact that in the DPP‐PSD firmware there is no parameter that allows the
software to know the decay time of the input signal and because the typical signals used in the DPP‐PSD
case are fast and so the probability of a signal overlap during an input stage saturation is low unless the
input rate is very high. This means that a correction taking into account this effect will be a higher order
correction.

4.2 Dead time estimation with the DPP-PHA firmware
The deadtime percentage is estimated by CoMPASS as:

1 –
(output_events + events_discarded_by_user_selection + saturation_events)

input_events
(4.3)

As in the previous case, the critical point is how to properly estimate the number of input events. In order
to do it, CoMPASS sums up the following events:

• output events going into the energy spectrum
• events rejected by user selection, if any
• events rejected by the software time sorting algorithm
• events rejected because the saturation of the digitizer input stage
• pile up events
• the so called ”poissonian events”

The last point goes as follows and it is the sum of two kind of events:

• estimated lost events during the Trigger Hold‐Off time: using a recursive procedure, a Poisson distri‐
bution is generated whose average value λ is the ICR× Trigger Hold‐Off time.

P(n_events_lost_during_THO) =
λn
n!

e–λ (4.4)

where λ = ICR× Trigger Hold‐Off.
The starting point is the first ICR and then with a recursive procedure improves the estimation at each
iteration;

• estimated lost events during a saturation of the input range: if an events is flagged as saturated,
the software does a small Montecarlo simulation in which it emulates a Poisson distribution whose
average value is the ICR × Saturation time. The time interval used for this simulation is the signal
Trapezoid Decay Time taken as the best estimation of the time required for the digitizer/MCA input
stage to come out of the saturation condition.

P(n_events_lost_during_input_saturation) =
λn
n!

e–λ (4.5)

where λ = ICR× Trapezoid Decay Time.
If the first emulated events falls in the time interval that is the minimum value between the trapezoid
decay time and the distance between the saturated event and the first following good event then
this emulated event is included in the ICR and the emulation proceed. If this events falls outside that
time interval or also after a time corresponding to the trapezoid decay time, it is assumed that event
would have been detected and so not added to the ICR. When the latter case occurs, the Montecarlo
emulation is stopped.
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5 Integrated charge evaluation fromCoMPASS
saved waveforms

In Waves acquisition mode, CoMPASS allows to save on the list files one of the analog traces produced
by the digitizer in addition to the onboard processed information (timestamp, integrated charge or pulse
height, PSD). In order to specifically save the input signal waveform samples, the user has to select ”Input”
as first trace in the CoMPASSPlot Waveform Inspector plot. The number of saved samples depend on the
Record lenght parameter set into the CoMPASS Settings→ Input tab.
The user can take benefit of this information for further offine processing and analysis such as evalating the
input signal rise time or recalculate the input signal integrated charge to reproduce the spectrum provided
by CoMPASS.

5.1 Integrated charge evaluation from waveforms
In order to try to reproduce the integrated charge information provided by the digitizer equipped with the
DPP‐PSD firmware and CoMPASS, the user should keep in mind the following:

• in theWaveform Inspector, the LSB unit of the Y scale refers to the digitizer ADC number of bit (Nbit).
For example, a 14 bit ADC, allows a sample evaluation scale between 0 and 16348 LSB. In general:

1 LSB =
digitizer_input_dynamic_range_in_Vpp

2Nbit
(5.1)

• in the Energy spectrum, the units of the X scale (tagged as ADC channels) are not related to the
digitizer ADC number of bit but refers to the arbitrarily units with which the digitizer provides the
information of the integrated charge. Tipically, the digitizer inner integrator is a 16bit integrator that
so provides the integrated charge over a 64K bin range.

Let’s now describe and example of charge integration supposing the following condition:

• the use of a x730 14 bit 500 MS/s digitizer with a 2 Vpp dynamic range

• to feed the digitizer with a 750 mV high and 100 ns wide square pulse

In case of a x730 digitizer configured to use the 2 Vpp dynamic range:

1 LSB =
2Vpp
214

≈ 0.12 mV (5.2)

Note: The digitizer belonging to the first generation do not feature a calibrated input range. For this reason
the above formula shows a ”≈” and not an ”=”.

When digitized, the above mentioned 750 mV pulse results in a pulse amplitude of 6250 LSB.
The charge content of such pulse is:

Q[pC] = (V× Δt)/Zin = (750 mV× 100 ns)/50 Ω = 1500 pC (5.3)

where 50 Ω is the x730 digitizer input impedance.
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Note: This is the calculation in the simplified case of a square pulse. In case of a real detector pulse, the
charge has to be calculated as a sum of the single sample contribution.

Note: in x725 and x730 digitizers, charge sensitivity values are different for the 0.5 Vpp and 2 Vpp dynamic
ranges. CoMPASS shows a single value for both that already takes into account the different dynamic range
value.

At this stage, the charge sensitivity parameter comes in play. The charge sensitivity weights the charge
contect of each bin of the energy spectrum and it is provided in fC/LSB units. This parameter is accessible
by the user in the CoMPASS Settings→ QDC tab.
In our example, supposing to consider a charge sensitivity of 80 fC/LSB, to convert that charge value into
channels unit that then will be used to fill the spectrum, we have:

Q[ch] = Q[pC]/Charge_sensitivity = 1500 pC/80 fC/LSB = 18750 LSB (or ADC ch) (5.4)

over a range 64K (65535) ADC ch.
Such charge value is given on 14 bit range (16K ADC ch) by CoMPASS that removes the last 2 less significant
bit. So that value of 18750 ADC ch in CoMPASS becomes 18750/4 = 4688 ch.
In addition, CoMPASS allows to do an additional spectrum rebin so, for example in a case of a rebinning on
4K (4096 ADC ch), the final value in the spectrum of the original charge content will be 4688 / 4 = 1172 ch.
CAEN provides a ROOT based demo code included in the CoMPASS installation folder at the path

”C:\CoMPASS\demo” in Windows

and

”/CoMPASS‐vX.Y.Z/demo” in Linux

that performs the integrated charge evaluation starting from the saved input signal waveform samples
saved into the list files.
Use of this script requires ROOT to be installed into the local computer.
In order to perform this analysis the user is required to provide in input to the script a list file in one of
the CoMPASS available format (ROOT, BIN, CSV) taking care of performing the data acquisition producing
this file in Waves mode. In fact, only when running in Waves mode and selecting in the CoMPASS Signal
Inspector the trace ”Input” as first analog trace CoMPASS will save the input signal samples in the list file.
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5.2 Windows operation
In the following, the instruction about how to operate the code in Windows with Visual Studio 2019 are
provided.

5.2.1 Create a Visual Studio project

1. Open Visual Studio;
2. Click on ”Create a New Project”. Or click on ”Continue without code”. Then, from main menu, click

on File→ New→ Project;
3. Choose Console App;

4. Choose a name for the project, e.g. myapp1;
5. Under Location, choose a directory where you want to store the project files and the codes;
6. Click Create;
7. This will create a new directory myapp1 inside the chosen location. This will also create a project file,

solution file and a C++ file of same name inside this new directory;
8. Replace the content of the new C++ file with the content of the C++ code you want to run. For the

present example, replace the content of myapp1.cpp by waveformAnalysis.cpp.;
9. Now link the ROOT libraries with the project as instructed below.
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5.2.2 Link ROOT libraries with a project in Visual Studio

1. The path to the installed ROOT directory should be saved as an environment variable ROOTSYS in
Windows (accessible fromWindows settings application);

2. The code should run with any of the recent ROOT versions. Take note of the platform (32‐bit, 64‐bit)
and the C++ standard (C++ 14, C++ 17 etc.) for the installed ROOT version. This example uses 32‐bit
Root v6.24.00 with ISO C++ 14 Standard. The platforms in Visual Studio should be chosen accordingly
from the Properties page of Solution Explorer.

3. Choose the configurations for code compilation from the given options. In the present case, it will be
compiled in Release mode for 32‐bit version. They should be selected as shown below.

4. From main menu, click on View → Solution Explorer to open the Solution Explorer tab, if it is not
already open.
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5. In the Solution Explorer tab, click on the project name (myapp1, in the present case), click on the
Properties icon to open the Properties window. This can also be accessed by right clicking on the
project name and clicking on Properties;

6. In the properties page, be careful to make all the modifications for the intended configuration and
platform i.e. Release mode, 32‐bit. Under Configuration Properties, click General. Select the pre‐
ferred C++ standard from the field C++ Language Standard;
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7. Under C/C++‐> general: Expand and Edit the Additional Include Directories field. Click on New line
icon. Add $(ROOTSYS)\include and press Ok.

8. Following the same method, go to Linker‐>General, expand and Edit Additional Library Directories.
Add $(ROOTSYS)\lib and press Ok.
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9. Under Linker→ Input, expand and edit Additional Dependencies

Add ROOT libraries required to build the project (one library name per line), e.g.:

libCore.lib, libRIO.lib, libHist.lib, libGraf.lib, libGpad.lib, libTree.lib.
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5.2.3 Build, run and terminate a project

1. Always open the .vcxproj file to edit, compile, debug and run the code;
2. To build the project, from the main menu click on Build→ Build Solution;
3. If it succeeds, run it by clicking Debug→ Start Without Debugging;
4. To terminate a project that is running on ROOT: from the ROOT plot canvas, click File→ Quit ROOT to

end the ROOT session. Then press any key to close the console window.
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5.3 Linux operation
To run the code in Linux, the user should compile and execute it outside ROOT with the following com‐
mands:

g++ WaveformAnalysisQDC.cpp $(root-config --glibs --cflags)
./a.out

The script does then ask the user to enter few additional information, the digitizer model, the used Input
Dynamic Range and the used charge sensitivity (see the following section).

5.4 Analysis example
In the following an example of such waveform analysis is provided. The original data acquisition has been
taken with a V1725 digitizer equipped with the DPP‐PSD firmware and running in Waves mode to get the
waveform samples within the saved list file. List data file have been saved in ROOT format.

Before proceeding with the code compilation, in the source code the user is asked to provide, besides the
list data file path, some information about the acquisition settings as shown in the following picture.

Fig. 5.1: Charge integration script source code excerpt showing the user defined block.

They are required to reproduce as much as possible the same results displayed by CoMPASS in its energy
spectrum.
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After the code compilation and before starting the processing, the script does ask the user to enter few
additional information, the digitizer model, the used Input Dynamic Range and the used charge sensitivity.

Fig. 5.2: View of the charge integration script I/O console.

Depending on the option selected in the source code, the script may display one by one the event raw
waveform, the calculated baseline and the charge integration gate limits.

Fig. 5.3: Example of a raw waveform displayed by the charge integration processing code. Blue dashed line is the
calculated signal baseline, red dashed lies are the charge integration gate limits.
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At the end of the data processing, the script does show 3 plots:

• the charge integration histogram in ADC channels units as displayed by CoMPASS for comparison
• the charge integration histogram in ADC channels units as calculated by the script from the rawwave‐

form
• the charge integration histogram in charge units (fC, pC or nC)

Fig. 5.4: Charge integrated histogram result in charge (left plot) and ADC channel (right plot) units.
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6 Generalized Timeof Flight analysis: theAny
to Any ΔT configuration

In many experimental scenarios it is required be able to perform a timing analysis (ΔT) in which the ref‐
erence T0 is provided not by a single fixed detector but, alternatively, by all the detectors used in the
experimental setup. Such kind of analisys is sometimes called Any to Any ΔT analysis.

Such kind of analysis requires a flexibility in the choice of the reference detector that currently is not avail‐
able within the CoMPASS infrastracture. For this reason, CAEN provides a ROOT based demo code included
in the CoMPASS installation folder at the path

”C:\CoMPASS\demo” in Windows

and

”/CoMPASS‐vX.Y.Z/demo” in Linux

that performs such analysis with the required flexibility. Single board and multiboard scenarios are man‐
aged by such script that allows to define energy selection criteria too.
Use of this script requires ROOT to be installed into the local computer.
In order to perform this analysis, the user is required to provide to the script a single time sorted list file in
whatever format generated by CoMPASS (ROOT, BIN or CSV). The code does not work with multiple input
files and with a non time sorted files.

6.1 Windows operation
Follow the samegeneral instructionprovided in the corresponding sectionof the Chapter Integrated charge
evaluation from CoMPASS saved waveforms.

6.2 Linux operation
Follow the samegeneral instructionprovided in the corresponding sectionof the Chapter Integrated charge
evaluation from CoMPASS saved waveforms.

6.3 Any to any analysis without energy selection example
In the following an example of such analysis is provided. The original data acquisition have been performed
with a DT5730 digitizer equipped with the DPP‐PSD firmware. 4 out of 8 channels have been used (0, 2, 4,
6). Single time sorted list data file have been saved in CSV format.

Before proceeding with the code compilation, in the source code the user is asked to provide, besides the
list data file path, some information about the acquisition settings as shown in the following picture.
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Fig. 6.1: Any to Any ΔT analysis script source code extract showing the user defined block. Energy selection range
reference values are set at negative values to have the script ignoring them.

They are required to be modified according to the user’s specific analysis requirements.

Note: The energy selection range reference values have to be set at a negative value to have the script
ignoring them.

After the code compilation, the script immediately starts the event processing, the ΔT histogram building
and, if the corresponding option has been selected, the histogram fit.

Fig. 6.2: View of the Any to Any ΔT analysis script I/O console.

At the end of the data processing, the script does show the histograms with the corresponding fit results.
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Fig. 6.3: Any to Any ΔT analysis results ‐ ΔT spectra.

6.4 Any to any analysis with energy selection example
In the following an example of such analysis is provided. The original data acquisition have been performed
with a DT5730B digitizer equipped with the DPP‐PSD firmware. 4 out of 8 channels have been used (0, 2,
4, 6). Single time sorted list data file have been saved in CSV format.

Before proceeding with the code compilation, in the source code the user is asked to provide, besides the
list data file path, some information about the acquisition settings as shown in the following picture.

Fig. 6.4: Any to Any ΔT analysis script source code exctract showing the user defined block.

They are required to be modified according to the user’s specific analysis requirements. In this case the
user has to specify the energy selection range for the channel that will act as start and the channels that
will act as stop. All the stop channels will share the same energy range selection settings.

Note: The energy selection range reference values have to be set at a positive value to have the script using
them.

After the code compilation, the script immediately starts the event processing. It builds the energy spec‐
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trum showing the areas corresponding to the users defined energy selection ranges and builds the ΔT
histogram in which the evens are those passing the user’s energy selection. If the corresponding option
has been selected, the histogram is fitted.

Fig. 6.5: Any to Any ΔT analysis results ‐ Energy spectra with selection areas.

Fig. 6.6: Any to Any ΔT analysis results ‐ ΔT spectra.
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7 Batch mode data acquisition using an ex‐
ternal script

One may need to run repetitive acquisitions over time to look for possible changes in the experimental
results over a long duration. It may be required to do a parameter scanning by acquiring data several times
with a different parameter value for each run. In these types of situations it could be convenient to let the
data acquisitions run repetitively without any human interaction. In addition, experimental condition may
restrict the user to access the data acquiring PC locally. For this purpose an example code written in C++
is provided with CoMPASS inside the demo folder which allows to access CoMPASS from a remote PC and
control running it with different settings.

7.1 How to use the code?
• After adding the boards in CoMPASS, click on ”Remote Control” in CoMPASS Plot window to enable

remote access of CoMPASS from another PC.

• Check connectivity by typing http://<ipAddress>:8080/compass/ in a browser where ipAddress is the
IP address of the PCwhere CoMPASS is running. This should display amessage ”Welcome to CoMPASS
data acquisition remote control”, if the connection is successful. If one is accessing from the same
computer where CoMPASS is running, they should use http://127.0.0.1:8080/compass/.

• One can run the code in two modes:

1. Batchmodewith different settings: in this case different CoMPASS configuration files can be used
for the runs and the acquisitions can be for different duration. One must create the config files
(inside CONFIG folder of the CoMPASS project) in advance. The config file names, acquisition
duration and run IDs should be specified in the userParametersFile.txt file.

2. Batch mode with identical settings: this mode runs with the same config file and for same dura‐
tion with auto‐incremented runID. Data will be saved periodically after completion of each run.
A single config file should be created in advance and kept inside the CONFIG folder of the CoM‐
PASS project. In case of manual configuration, the configurations should be set on the CoMPASS
gui before starting the acquisition. In this mode, the auto‐incrementation of runID is enabled by
default.

• To compile and run:

– Linux: In a terminal, type the following lines to compile and run the code.

g++ batchAcquisition.cpp -o batchAcquisition
./batchAcquisition

– Windows (Visual Studio):
Create a new project and add the batchAcquisition.cpp file to the project. Set the project to
use C++17 standard. Include the library ws2_32.lib as an additional dependency in the project
properties (under Linker→ Input). Build and run the project.

The user needs to make sure that no folder is already present inside the CoMAPSS project directory having
the same name as the runID specified in the userParametersFile.txt file. Otherwise, the run will not start.
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7.2 Input parameters file
The input parameters for the code are read from a text file specified by the user. By default the code
looks for a file named userParametersFile.txt in the same folder where the executable is located. To use a
different file name or path, the user needs to provide its name (with correct path) as an argument while
running the code.

• Linux:

./batchAcquisition newParametersFileName.txt

• Windows (Visual Studio):
Specify the new parameters file name in the ”Command Arguments” field of the Debugging section
of project properties.

In the userParametersFile.txt file, order of the inputs needs to be preserved. No field should be left blank.
Multiple values for a parameter can be specified in a single line separated by commas. Lines starting with #
are treated as comments and ignored. The input parameters are described below according to their order
of appearance in the file.

1. Server IP address (string): IP address of the computer where CoMPASS is running. For local connec‐
tion, use 127.0.0.1.

2. Server port number (integer): Port number for remote connection to CoMPASS. Default is 8080.
3. Server wait time (integer): Time in seconds to wait after sending a command to the server before

sending the next command. A high event rate acquisition may need a longer wait time.
4. Acquisition duration (list of integers): Duration(s) of data acquisition in seconds. If there is a single

value, it will be used for all the acquisitions. The actual run time will be slightly shorter than the
specified duration due to the time taken by the server to process the commands.

5. Config file names (list of strings): Name(s) of the CoMPASS configuration file(s) to be used for the
acquisitions. The config files should be present inside the CONFIG folder of the CoMPASS project. If
there is a single value, it will be used for all the acquisitions. If the value is ”0”, manual configuration
mode will be enabled. In that case, the user should set the configuration on the CoMPASS GUI before
starting the acquisition. The runID, its auto‐incrementation and duration for each run must be set in
the userParametersFile.txt file.

6. Run IDs (list of strings): Run ID(s) to be used for the acquisitions. If there is a single value, it will be
used as the base run ID and automatic incrementation of Run ID will be enabled. New folders with
the auto‐incremented runIDs will be created if data saving is enabled. If multiple values are specified,
they will be used for the corresponding acquisitions.

7. Number of acquisitions (integer): value of this parameter is used only in the identical settings mode.
It specifies the number of times the acquisition should run. If set to 0, the acquisition will run indefi‐
nitely until stopped manually from the CoMPASS GUI.

Example of a typical userParametersFile.txt file is given below:

# Server ip address
127.0.0.1
# Server port number
8080
# Time (in s) to wait for server to process requests
8
#
# Acquisition durations in seconds
120, 180, 240, 60, 1800
# CoMPASS config files

GD6300 ‐ CoMPASS Quick Start Guide rev. 26 169



config1.xml, config2.xml, config3.xml, config4.xml, config5.xml
# Run IDs
run1, run2, run3, run4, run5
# Number of acquisitions
15

# End of file
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8 Troubleshooting
CoMPASS helps the user in identifying a the origin of a possible error condition by means of popup that
appear and inform the user about the occurred error condition and provides additional information. In the
following some examples and in Tab. 8.1 a summary of the most common troubleshooting is provided.

Fig. 8.1: First example of Assertion Failed Error at the CoMPASS Startup.

Fig. 8.2: Second example of Assertion Failed Error at the CoMPASS Startup.

Fig. 8.3: Not supported firmware error popup.
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Fig. 8.4: Not supported board model error popup.

Fig. 8.5: Overtemperature error popup.

Fig. 8.6: PLL Lock loss error popup.

Fig. 8.7: Polling (communication interrupt) error popup.

Fig. 8.8: Data readout error popup.

Fig. 8.9: Memory allocation error popup.
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CoMPASS Issue Fixes

0 (Linux Only) CoMPASSPlot does not
start and shows exit value ‐139

Your Linux distribution is missing some CoMPASSPlot re‐
quired dependecies. Remove CoMPASS and install it
again using the SNAP package instead of the .tz.gz one.

1

(Almalinux Only) CoMPASSPlot re‐
quires GLIBC 2.35 or higher and
GLIBCXX 3.4.30 or higher which are
not available for Almalinux 9.4 or
lower

Change yiu Linux OS distribution to one supporting these
libraries versions or install CoMPASS using the SNAP
package.

2

(Linux on Virtual Machine Only)
CoMPASS shows some graphical is‐
sues like icons or buttons or menus
not well displayed

Change the graphical enviroment used by your Linux dis‐
tribution running on the Virtual Machine (eg to Gnome,
KDE or Xorg)

3
(Windows only) CoMPASS does not
start the installation wizard auto‐
matically

Try launching the installer ”.exe” file from PowerShell us‐
ing the following command:
.\CoMPASS_v2.6.0‐Setup.exe /LOG=”test.log”»

4

CoMPASS GUI or CoMPASSPlot do
not start or an Assertion fails oc‐
curs as per the first example above
shown (*.cpp file mentioned) (Win‐
dows only)

Check the CoMPASS dependencies installation in your pc.
The following software has to be present:

1. CoMPASS
2. Windows SDK AddOn
3. Windows Software Development Kit ‐ Windows

10.0.19041.685
4. Visual Studio Build Tools 2019
5. Microsoft Visual Studio Installer
6. Microsoft Visual C++ 2015‐2019

If one of them is not present, contact the CAEN Support
service.

5
Assertion failed as per the first
or second example above shown
(*.cpp or *h file mentioned)

This error occurs at the CoMPASS startup and is related to
some incompatibilities between the SDK required by the
CoMPASS embedded ROOT and another possible ROOT
version or the Visual Studio 2022 SDK 10.0.22000 already
installed on the pc.
Try to remove any ROOT and the mentioned Visual Stu‐
dio 2022 SDK 10.0.22000 already installed on the pc and
install CoMPASS again. After that you may try to rein‐
stall your own ROOT distribution. Visual Studio 2022 SDK
10.0.22000 in, on the contrary not compatible with CoM‐
PASS.

6 Board not supported Check the Quick Start Guide for a list of supported
boards.

7 Firmware not supported Check the Quick Start Guide for a list of supported
firmware.
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8
Over temperature error: CoMPASS
has detected that the digitizer is
overheated.

Check that the digitizer is properly ventilated:
• If you are using a desktopdigitizer, please verify that

the fans are not blocked and that there is enough
space on both lateral sides for a proper air flow;

• If you are using a VME or NIMdigitizer, please check
that the crate is a ventilated model, that the fans
are not blocked and that there is enough space
on both lateral sides (in case of a minicrate) or on
the top and bottom side (in case of a vertical crate
model) for a proper air flow.

9

PLL lock loss: CoMPASS has de‐
tected a digitizer PLL lock loss con‐
dition. This condition is due to a
loss of the reference clock.

Check the digitizer front panel LED status. If the PLL Lock
LED is off or blinking proceed with the following steps:

• If you are using an external clock signal, please
check that the external clock is active and
that the cable connection into the digitizer
CLK_OUT/CLK_IN connectors is properly done.

• If you are not using an external clock signal first
power cycle the board. If the PLL Lock LED remains
off, the digitizer PLL needs to be reprogrammed.
Use CAEN Upgrader software to do the PLL repro‐
gramming.

• In case of VME digitizers, please check that the
CLOCK EXT/INT switch is in the right position. Re‐
member to properly reprogram the PLL using the
CAEN Upgrader software every time you switch
from EXT to INT and viceversa even if the PLL Lock
led is on.

10

ADC Shutdown: CoMPASS has de‐
tected a shutdown of the digitizer
ADC.

Typically this condition is due to board overheating. Fol‐
low the instructions reported for the board Overtemper‐
ature condition.

11
Error polling: CoMPASS has lost the
communication with the board.

Check that the digitizer is ON and that the USB or the
Optical link cable is properly connected.

12

Readout error: an error occurred
during the data readout from the
board or from the offline run file.

Contact the CAEN Support Service .

13

Memory allocation: Process CoM‐
PASSPlot.exe tried to allocate more
memory than the maximum avail‐
able.

Close other running applications or reduce the number of
digitizers in the current project. Contact the CAEN Sup‐
port Service for more information

Tab. 8.1: CoMPASS Troubleshooting cases.
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9 Technical Support
To contact CAEN specialists for requests on the software, hardware, and board return and repair, it is nec‐
essary a MyCAEN+ account on www.caen.it:

https://www.caen.it/support‐services/getting‐started‐with‐mycaen‐portal/

All the instructions for use the Support platform are in the document:

A paper copy of the document is delivered with CAEN boards.
The document is downloadable for free in PDF digital format at:

https://www.caen.it/safety‐information‐product‐support
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